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0 . 1 INE IGHT  MODEL OVERV IEW

InEight Model is a platform for model and information aggregation that hides the complexity of
managing versions and sharing information across teams.

Import, contribute, modify, and recall models and information in a variety of ways. InEight Model
supports BIM to FM, coordination, field management, design renderings, visual scheduling, sensor
monitoring, and more. Collect and reuse data throughout the design, construction, and operations
phases without the current limitations of: managing file types, delays in uploading and downloading
files, version control, reentering data, and the difficulties of managing numerous point-solution
applications.

0 .1 .1 EASILY SHARE MODELS AND INFORMATION

When an internet connection is available, you are able to share models, information, documents, visual
styles, and much more with other users. We store your data on our servers and sync it to your local
hard drive whenever you’re online. Offline, your project data is kept in a central location on your
computer. When you're ready share, login and sync online. As teammates sync and share, you can
choose to view and interact with the information that only pertains to you
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1 . 1 INSTALLAT ION

InEight Model is cloud-hosted software with a Microsoft Windows-based application focused on 3D
model content. Model is not a model-authoring environment; rather, it provides the capability to
transform engineering and architectural models into construction and owner models.

The Model Windows application is supported by plug-ins and a locally stored cache folder
(InEightModel_Cache). Before you download and run the Model application on your desktop, review
the "Client System and Mobile Device Requirements Specification".

Local admin permissions are required to install InEight Model.

1 .1 .1 STEPS

INSTALL THE INEIGHT MODEL DESKTOP APPLICATION

1. Open https://ineight.com/ineight-software-downloads/ in your web browser.

2. Under InEight Model, selectModel Installer - Download to begin downloading the
InEightModel-64bit.exe file to your downloads folder.

3. After the download is complete, double-click the file to run the application.

RELEVANT LINKS

Model Installer Direct Download Link

Client Requirements Document

User Managaement Link

InEight U - Basics Certfication

InEight U - Setup and User Management Course

1 . 2 PLUG- INS

You can add InEight Model content from an authoring application using plug-ins or through IFC import.
Each model imported to Model is considered a Model stream. For more information, see Model
streams overview.
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Plug-ins are installed automatically as part of Model Application installation. When you update Model,
the plug-ins are also updated. The plug-in applications must be closed when Model is updated.

When a plug-ins does not update, close and re-open the plug-in application to update the
plug-in.

The plug-ins listed below are installed and updated, except for the Microsoft Excel plugin.

Plug-in Description

Excel plugin
(Windows)

Microsoft Excel provides a means to add custom data into Model and a
means for visual reporting.

Revit plugin
(Windows)

The Revit plugin provides a means for exporting models from Revit
into Model.

AutoCAD plugin
(Windows)

The AutoCAD plugin provides a means for exporting models from
AutoCAD into Model.

Navisworks plugin
(Windows)

The Navisworks plugin provides a means for exporting models from
Navisworks into Model.

IFC import
(Windows) *

The IFC import provides a means for importing IFC (Industry
Foundation Class) type files into Model.

* Internal to Model desktop

RELEVANT LINKS

Excel Plugin Download Link

Watch Plugins Model Video

1 . 3 LAUNCH MODEL

1 .3 .1 MODEL NOT INTEGRATED WITH INEIGHT
PLATFORM

In Model (not integrated with Platform) you can create projects, user accounts, assign permissions, and
assign users to projects. When you create a new user, the user receives an email with login
information.
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To launch Model, you can click the Model icon on your desktop or select Model from the Windows
Start menu. At the login screen, you can enter the login information provided in the email. You can also
sign in using single-sign-on (SSO).

After you sign in, the Load Project dialog window shows the projects that you have been assigned to.
Select a project to open.

InEight Model has online and offline capabilities which can be toggled at the login screen and within
the application. The best practice is to sign in online to ensure your local cache data is up to date with
the latest project information, and then use Model offline when needed.

1 .3 .2 MODEL INTEGRATED WITH INEIGHT PLATFORM

In Model (integrated with Platform) you can create projects, user accounts, and assign permissions.
When you create a new user, the user receives an email with SSO login information.

To launch Model, you can click the Model icon on your desktop or select Model from the Windows
Start menu. At the login dialog box, you can sign in using your SSO information provided in the email.

After you sign in, the Load Project dialog window shows all Model projects created in Platform.

1 .3 .3 CONSIDERATIONS

You must have administrative permissions

RELEVANT LINKS

Platform User Management

Watch Launch Model Video

1 . 4 MODEL CACHE

Model stores your project’s data in a local folder named cache. The cached project data is accessible
when you are offline. To use the project offline, it is recommended to sign in online to sync the latest
project information.

The default cache location is %localappdata%/InEight/Model/cache directory.

If your existing installation is not in the default location, switching to the default path is highly
recommended. To view your current path and update the default location click the ellipsis in your sign
in screen > Settings > Cache Path. You can then select a new location.
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The cache must remain local on the computer and cannot be synced live to external locations.

Do not delete your InEight Model cache folder. In rare instances you can delete the folder
to fix cache issues.

1 .4 .1 MOVE CACHE TO A NEW LOCATION

If you installed Model before 23.10, you can change the location of your InEightModel_Cache folder in
Settings > Cache Path. Changing the location of your cache folder without moving your existing cache
folder data will force Model to recache the project data. This can be time-consuming depending on the
number of projects and their size.

InEight Inc.  |  Release 24.9 Page 29 of 558

Model User Guide 1.4 Model cache



1 .4 .2 CONSIDERATIONS

l The registry key located in Computer\HKEY_CURRENT_USER\SOFTWARE\InEight\Model\Cache
defines the path of where the InEightModel_Cache folder resides. Updating the path in the
registry will not relocate the existing cache folder to a new defined location

l If the cache folder is deleted, Model must re-cache the project data. This can be time-
consuming.

1 .4 .3 STEPS

MOVING YOUR EXISTING INEIGHTMODEL_CACHE FOLDER

To move your existing Model cache folder, do the following recommended process. The process must
be done on the local machine of each user.

1. Open Windows File Explorer, and then create a new folder or open the new folder location.

2. Open another Windows File Explorer window, and then select your existing InEight Mode_Cache
folder location.

3. Move your existing InEightModel_Cache folder into the new location.

4. Launch the InEight Model application.

5. Click the Settings icon in the login window, and then change the Cache Path to the new location.

6. Sign in to InEight Model.

RELEVANT LINKS

Watch Cache Model Video
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LESSON 1 REVIEW

1. What should you do prior to downloading and installing InEight Model?

a. Delete your authoring tool from your computer

b. Check your system's requirements

c. Download the correct plugin for your authoring tool

d. None of the above

2. What does InEight Model offer to support authoring tools?

a. AutoCAD plugin

b. Revit plugin

c. IFC importer

d. Navisworks

e. All of the above

3. You can create a new model from InEight model.

a. True

b. False

LESSON 1 SUMMARY

As a result of this lesson, you can:

l Install InEight Model
l Install plugins
l Launch InEight Model
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2 . 1 CREATE A PROJECT

CREATE A PROJECT INTEGRATED WITH INEIGHT PLATFORM

When Model is integrated with InEight Platform, all projects are created in Platform.

CREATE A PROJECT NOT INTEGRATED WITH INEIGHT PLATFORM

1. From the top menu, select File > New Project.

l The New Project dialog box opens.

2. Name the new project.

3. Click OK.
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l The creation in progress dialog opens.

4. Click OK.

After a project is created it cannot be renamed.

2 . 2 LOAD A PROJECT

Logging into an account provides access to projects in that account. To access a specific project, you
first must load it.

InEight Model integrated with InEight Platform will show all projects listed in Platform in
the Load Project dialog box.
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2.2 STEP BY STEP 1 — LOAD A PROJECT

1. Select File > Load Project....

l The Load Project dialog box opens and shows all projects you have access to.

2. Select a project.

3. Select OK.
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Right-click on a project. This provides additional options:

l Set as Highest Priority: This pushes the project to the top of the list when projects are
being Synced.

l Stop Syncing

l Hide Project From All Users: Administrators only have this functionality

2 .2 .1 MANAGE SYNC

You can only open models that have been cached to your computer. Manage Sync allows you to select
and reorder the projects you want to sync. After projects are synced, they are synced into the
InEightModel_Cache folder.
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l Download column: select on ^ Top to move a project to the top of the list to be synced first
l Sync column: If Sync is checked, then the project will sync. If Sync is un-checked then the
project will not sync

2 .2 .2 REMOVE PROJECTS FROM CACHE

You now can free up disk space by using the Remove project from cache option. When you finish
working on a project, remove the project from your cache in the Load Model Project > Load Project
tab. Right-click on a project from the list, and then select Remove Project from Cache to remove the
projects cache.
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You must exit InEight Model once a project has been removed before accessing and
working in another project.

2 . 3 CREATE A NEW PROJECT FROM
TEMPLATE

In Model (not integrated with InEight Platform) you can create new projects from existing projects as a
template. The following items, if existing in the template project, will be created with the new project:

l Project Structure:
l The Project Structure folder structure will be present in the new project.
l No existing model streams will be present in the new project.

l Master Presets:
l The Master Preset folder structure will be present in the new project.
l No existing Master Presets will be present in the new project.
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l Styles:
l All existing Style Sets with assignments to existing and non-existing tags with be
present in the new project.

l All existing customer Styles will be present in the new project.
l Tags:

l All existing custom tags will be present in the new project.
l Archive Library:

l The Archive Library folder structure will be present in the new project.
l No existing documents or labels will be present in the new project.

InEight Model integrated with InEight Platform does not provide a means to create a
Model specific project from a template.

2 .3 .1 CONSIDERATIONS

l You must have admin permissions to create new projects.

l You can use projects as templates when Model is not integrated with InEight Platform.
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2 .3 .2 STEPS

CREATE A NEW PROJECT FROM TEMPLATE

1. Select File > New Project from Template.

l The New Project dialog box will open

2. Type in the name of the New Project.

l The Template Project dialog box will open.
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3. Select the project to use as the desire Template, then click OK.

l A validation dialog box will open

4. Click Yes, if the information is correct.

5. Click OK, then load your new project

LESSON 2 REVIEW

1. Before you can import a model, you should first create a project.

a. True

b. False

2. The Manage Sync folder allows you to sync projects to your _________________ .

a. Model Library

b. Cache Folder
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c. Model Stream

d. Plugin Folder

As a result of this lesson, you can:

l Create and load a project
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3 . 1 MODEL STREAMS OVERV IEW

A model that is published (imported) into InEight Model is referred to as a Model stream, whether they
are exported from a design application or imported from a design file type using plugin tools.

When models are published the following Tag Names are created:

l InEight_Object_Total_Surface_Area

l InEight_Object_Volume

Each plugin tool has standard tags that are included in every published model as shown in the
following tables:

Tag category Tag value

Model Stream <model name>

Tag_Level <level names>

Tag_PhysicalType Window, Floor, Door, etc.

Revit_Family_Type <Family Instance names>

Revit_Function <Walls and Floors>

Material Name - CAD <face material names>

Revit



Tag category Tag value

Model Stream <model name>

ACAD Block <block names>

ACAD Layer <layer names>

ACAD Material <material names>

AutoCAD

Tag category Tag value

Model Stream <model name>

IFC Class <IFC class names>

IFC Layer <IFC layer names>

IFC Material <IFC material names>

IFC Name <IFC name names>

IFC

RELEVANT LINKS

Plugins

Project Structure Overview

Model Stream Management

Model Stream Permissions

Organize Model streams

3 . 2 CONF IG SETT INGS

Config Options gives you the ability to define the parameters, or metadata, that will export along with
the geometry, as well as providing some advanced options for applying various transformations.

The Config Options column in theModel Exporter will report three different states.

1. Basic - Indicates the Config Options have not been defined by you. This is the default state
of an unpublished Model Stream.

2. Previous - Uses the same Config Options as a previous export. This indicates that you're
updating an existing Model Stream and not publishing a new one. The settings are pulled
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from the previous project and are not dependent on the Model Stream being updated from
the same computer, or even by the same user.

3. Custom - Indicates that the Config Options have been modified during your current
session.

Config Options can be configured in bulk by multi-selecting the listed Model Files in
the Model Exporter window then clicking within any of the Config Options field
that corresponds with your selection.

The Parameters tab in the Config Options window allows the user to define what metadata will be
exported along with the geometry. The Basic Tags are also displayed along the top of the search bar.
Basic Tags will be included in every export regardless of configuration.
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Choose your desired tags and/or properties by expanding a category and checking the box next to a
value. In the image below, we see that the Voltage and Wattage for the Electrical Equipment will be
exported as a tag and that the Length and Volume for Structural Columns will be exported as
properties. Additionally, clicking in the Click to rename... field in the Tag Alias Name column, the
Length of the Structural Columns has been renamed to Cut Length. Renaming these values is a quick
and easy way to achieve consistency when pulling geometry and metadata from files authored by
various different organizations that may be using different values to represent the same data.
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With the Show Unselected box checked (in the bottom left corner), all available parameters will be
displayed. With the Show Unselected box un-checked, only the selected parameters will be displayed,
this allows the user to easily view the current configuration.
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Use the Import Parameters and Exporter Parameters buttons to save your configuration to a local file
or to import a previously saved configuration.

The Advanced tab allows Scale, Rotate, and Translate (move) options upon export. Settings configured
in the Advanced Options are retained in future model updates.
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To change the name of the Model Stream simply click in the Rename Model Stream field and enter the
desired name.

If desired, check the Include Lines in Export box to include 2D and 3D line work.

l Scale, Rotate and Translate / Move provides a way to adjust the model as needed up
export

l Rename Model Stream provides a way to rename the model file upon export
o The new name will appear in the Objects panel and as a value within the Tag
Category "Model"

l Include Lines in Export provides a way to include 2D and 3D line work upon export

3.2.0 .1 OVERVIEW - CONFIGURING MODEL STREAMS
PARAMETERS TAB

Item Description

1 Parameter Name Displays the Property Set Name and the Property Name of
the metadata.

2 Export Property Will export the Property Name with the existing value for
each model object.

3 Create Tag Will utilize the Property Name to create a Tag name with the
existing value for each model object.

4 Tag Alias Name Provides the capability to control what the Tag name is
during the export of the model.

5 Export Parameters Once the desired “Export Property”, “Create Tag,” and “Tag
Alias Name” columns have been selected and filled out, then
select Export Parameters to save these settings to use on
similar models.

6 Import Parameters If previous parameters have been exported, then select
Import Parameters to populate Parameters.
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3.2 STEP BY STEP 1 — CONFIG SETTINGS - PARAMETERS

1. Within the Model Exporter window, select Basic.

l The Config Options window opens with the initial focus on parameters

The Parameters tab in the Config Options window allows the user to define what
metadata will be exported along with the geometry.

The Basic Tags are also displayed along the top of the search bar. Basic Tags will be
included in every export regardless of configuration.
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2. Select the desired tags and/or properties to export with the Model Stream.

l Create Tag will create a tag category and tag value metadata for the relative model
objects

o Column Location Mark, Length and Volume will be the tag categories within
InEight Model

l Export Property will create property category and property value metadata for the
relative model objects

o Fire Rating and Manufacturer will be the Property Categories within InEight
Model

l Tag Alias name will rename the Category name
o Length will be renamed to Cut Length during the export
o Renaming these values is a quick and easy way to achieve consistency when
pulling geometry and metadata from files authorized by different organizations
that may be using different values to represent the same data
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3. Select or unselect Show Unselected.

4. Select Import Parameters or Export Parameters.

5. Select OK when you have completed.

3.2 STEP BY STEP 2 — CONFIG SETTINGS - SCALE / ROTATE / XYZ

1. Select the Advanced tab from the Model Exporter.
l The Advanced tab shows options to manipulate the model.
l If the Scale Factor, Rotate, and/or the XYZ are needed to adjust the model then they
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are applied in the displayed order from top to bottom (Scale Factor > Rotate > XYZ).

2. Add a scale factor to adjust the scale of the model as needed.

3. Add a Rotation angle by degrees as needed.

4. Add X, Y, and Z coordinates as needed.

5. Click OK when done with Config Options.
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3.2 STEP BY STEP 3 — CONFIG SETTINGS - RENAME MODEL STREAM

1. Select the Advanced tab from the Model Exporter.
l The model file name might change if the designer or architect puts a revision status
or date on the file name with every version.

l The Rename Model Stream lets you rename the model stream without changing the
model file name and provides a consistent model stream name for all end users to
access.

2. Type a Model Stream Name.
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3. Click OK when done with Config Options
l The Project Structure shows the Renamed Model Stream and, in the Revision
History, shows the Model Stream Source File name.

l The Tags and Objects panel shows the Renamed Model Stream in the Object tab for
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the project team to use throughout the project.

.

3.2 STEP BY STEP 4 — CONFIG SETTINGS - LINK TO A DIFFERENT
MODEL STREAM

1. In the Model Exporter, you might see a message of “Resolve Model Conflict…**” in the
Location column. This is a result of multiple models loaded with similar names. Click
Resolve Model Conflict…**
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2. If the model stream is not shown, then click Export as New…
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3. Choose a location.
l You can only select the parent level or a group level location.

4. Click OK to close the Choose Location dialog box.

5. Click OK to close the Resolve Conflict dialog box.
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6. Click Basic in the Config Options column.

7. Click the Advanced tab.

8. Click Choose different model…
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9. In the Choose Location dialog box, select a Model Stream to link to.

10. Click OK when done with Config Options.

3 . 3 EXPORT SETT INGS

When available for plugin, Export Settings lets you configure the model location options and the model
visibility options.

3.3.0 .1 EXPORT SETTINGS OPTIONS:

Revit Location refers to the coordinate systems contained within the Revit Project and can be defined
three ways
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l Ask on Export - The Model Exporter will prompt the user to select the appropriate
coordinate system during export

l Use Revit Project Location - Uses the active project location
l Use None -Resets project location to default values

Export Selected will require the user to have an active selection prior to initializing the Model Exporter
and will only export selected objects

Visibility tells the Model Exporter which geometry to include in the export

l Export Visible - Exports all visible content within the 3D view
l Export Visible + Room Volumes - Exports all visible content within the 3D view plus room
volumes

l Export All - Exports all geometry found within the Revit project, even if it's hidden in the
active 3D view

Info displays some basic information about your current session

l InEight Connection - Displays the current status of the Model Exporter's communication
with InEight Model

l Connected - Online - Connection is established to the server
l Disconnected - Offline - Not connected to the server. Check your Internet connection or
login to your project within InEight Model

l Logged-in as - The currently logged in user
l Cache Location - The path of the InEightModel_Cache folder

3 .3 .1 STEPS

EXPORT SETTINGS

1. In the Model Exporter window, select Change Export Settings / Show Info … to open the Export
Settings window.
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l The Export Settings window opens
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2. Complete your changes, and then click OK.

3 . 4 MODEL REV IS IONS

Model revisions might occur during project execution.

3.4.0 .1 MODEL WITH SAME NAME

Follow the same process of the initial exporting from AutoCAD or Revit or importing an IFC file.
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Notice the following parameters while updating the model.

l The Model file is the same file name that you have opened to update.
l The Location is populated from the previous selection and lets you export as a new model.
l The Config Options use the previous settings.

3.4.0 .2 MODEL WITH A REVISED NAME

Follow the same procedure of the initial exporting from AutoCAD or Revit or importing an IFC file.

Notice the Model file has .rev2 added to it, different from the initial file name.

The system puts the revised model stream in the previously selected location.
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3.4 STEP BY STEP 1 — RESOLVE MODEL CONFLICT

1. Select Resolve Model Conflict...

l The Resolve Conflict window opens

2. Select the applicable model stream to be revised.
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3. Select Export as New... if this is a new Model Stream.

l The Choose Location window opens.
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4. Select the preferred location in the Project Structure.

5. Select OK to complete.

When exporting a model with a similar name to more than one model, the system
shows Resolve Model Conflict… in the location column.

3 . 5 ANALYZE MODEL CHANGES

Analyze Model Changes provides the ability to compare models over time. The comparison is not
limited to two models, the comparison is triggered off two calendar dates, which could include 2 or
more model stream revisions.

The comparison will provide which model stream was compared, how many objects were added, how
many objects we updated, and how many objects were removed.
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The comparison will also create a new Tag Category named Tag_User with two tag values: (date range)
(Model Stream Name)_added and (date range) (Model Stream Name)_updated.

Also, a Style Set is created within the Styling Panel with the name (date range) (Model Stream Name)
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3.5 STEP BY STEP 1 — ANALYZE MODEL CHANGES

1. Have two versions of the model stream published.

2. Within the Project Structure dialog box, select on a model stream to identify the date range
to use for the comparison.
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3. Close Project Structure dialog box.

4. Close Project Structure dialog box.
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5. Select the Model Stream, set the date time frames, then click OK.

l The Analysis of Model Changes Completed dialog box will open

l Tag_User category was created with two values “_added” and “_updated”
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l A Style Set was created coloring the “Added” objects Lime Green and the “Updated” objects
Orange
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4 . 1 PROJECT STRUCTURE OVERV IEW

Project Structure is where model streams are housed after the export from authoring tools or the
import of IFC type files. It provides the ability to interact with model streams by grouping and
organizing, removing, temporarily disabling, accessing the revision history, importing other models
streams from other projects in the environment, and more.

4 .1 .1 PROJECT STRUCTURE PANEL

To access the Project Structure panel, Select File from the menu bar at the top of the screen. Then,
select Project Structure.

This will open the Project Structure panel.
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By selecting the project name within the tree structure, all the project Revision History will be
displayed. Select on a revision to review the Revision Notes.
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4 . 2 ORGAN IZE MODEL STREAMS

Create groups within the Project Structure tree to organize the model streams for the project. Groups
can be created before and or after model streams have been imported into the project. Model Stream
Placeholders can also be created identifying anticipated or planned project model streams.

4.2 STEP BY STEP 1 — CREATE GROUPS

1. Select the project name.

2. Select the Group icon.
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3. Type in a group name, then click OK.
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4. Drag and drop model streams into group folders.
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l Possible results of organized models

Once a group name has been created it cannot be renamed. A new group name will need
to be created, then you can drag and drop the model streams from one group to the
other.
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4.2 STEP BY STEP 2 — DELETE GROUPS

1. Select the group name to be deleted.

2. Select the Remove icon.
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l The Remove Model Group confirmation dialog box will open

Any model streams within the group that is being removed will be removed as well.
The model streams will remain in the database, but not visible within the current
project.

The Project Structure will be replicated within the Objects tab within the Tags and
Objects Panel.
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4.2 STEP BY STEP 3 — CREATING A MODEL STREAM PLACEHOLDER

1. Select on the Project or the Group for the desired Model Stream placeholder.

2. Select the Model Streams icon.
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3. Select the Add Placeholder icon.

l The Remove Model Group confirmation dialog box will open

4. Type in the anticipated or planned Model Stream name.

l The Model Stream Placeholder will appear in red until a model stream is uploaded in
its place
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4 . 3 MODEL STREAM MANAGEMENT

When a model stream is updated from a plugin, a new revision is created in the Project Structure. The
Project Structure lets the administrator switch the revision of any given model stream in the project.

4.3 STEP BY STEP 1 — CHANGE THE ACTIVE MODEL STREAM
REVISION

1. Within the Project Structure tree, select a model stream.

2. Double click on an older revision.
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The current active revision is highlighted in green and the most recent prior
revision is highlighted in yellow.

If an administrator changes the revision of any model stream and proceeds to save
the project, any user loading the project or accepting updates will also be viewing
the historical revision chosen by the administrator. This allows the administrator to
roll back to a previous revision, if the latest revision is incorrect or non-compliant.

A model stream will be highlighted in yellow if there is a new model stream
revision, but not set as the active revision.
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4.3 STEP BY STEP 2 — UPDATE MODEL STREAM REVISIONS

1. Within the Project Structure panel, click the Update All icon.

Update all will update all model streams to the latest revision.

The Update All icon will not be available if there are no old revisions active.

4.3 STEP BY STEP 3 — DISABLE MODEL STREAMS

1. Uncheck the box next to the model stream.

2. Click OK.

3. Save the project.
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l Once the project is saved, then the model stream is hidden from the project users

4.3 STEP BY STEP 4 — REMOVE MODEL STREAMS

1. Select a model stream.

2. Select the Remove icon.
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l The Remove and Discard dialog box will open

l Remove Only -will remove the selected model stream from the current project
but it will not remove it from the database

l Remove and Discard – will remove the selected model stream from the
database.
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4.3 STEP BY STEP 5 — ADDING MODEL STREAMS FROM OTHER
PROJECTS

Model streams that have been removed with the Remove Only command can be reloaded through the
Add Model Stream icon.

Model streams within the same environment, but in a different project, are accessible to be included in
any project within the same environment.

1. Select the root project name or a group folder.

2. Select the Model Stream icon.
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l The Model Stream dialog box will open

3. Select the desired models to be added to the current project, then click OK.

The select model stream of the particular revision date will be added to the current
project along with all older revisions of the model stream.
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4.3 STEP BY STEP 6 — PUBLISH A MODEL STREAM INTO A
PLACEHOLDER

Model Stream Placeholders show as red until a model has been published to replace it.

1. With Model open and the Design Authoring tool (that is,Revit) open, select the Export
Model Stream icon.

l The Model Exporter dialog box opens.

2. Select Choose Location.
l Even though there is a placeholder that nearly matches the name of the design file,
the design file has not been published yet, so it is recognized as a new model
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l The Choose Location dialog opens.

3. Select the folder where the Model Stream placeholder is identified.
l In this example, Mechanical is the placeholder.
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4. Click OK.

The new model stream does not replace the placeholder until it is linked to it.
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5. Select Basic config options.
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6. Select the Advanced tab.
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7. Select Choose different model...
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8. Select the model stream placeholder, and then click OK.
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9. Click Start.

10. Save the model stream to the project.
l In the Project Structure, the new Model Stream has replaced the Model Stream
placeholder.

4 . 4 MODEL STREAM PERMISS IONS

Permissions can be set at the Group level within the Project Structure. Nested groups inherit parent
group permissions.

By default, group permissions inherit project permission for users and user groups.
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For best practice, only apply User Groups to projects instead of individual users. This minimizes the
management of applying permissions to Model Streams.

4.4 STEP BY STEP 1 — APPLY PERMISSIONS TO GROUPS

1. Open the Project Structure dialog box.

2. Right-click on a group and select Edit Group Permissions.

l The Edit Model Group Permissions dialog box opens.

l By default, the User Parents Group Permissions is already checked.

3. Uncheck the Use Parent Group Permissions check box to apply specific User Group permissions.
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l All users and User Groups show if they have been assigned to the project.

4. Users and User Groups can only have one of the following permissions:

l Can Read – read-only permissions.

l Can Read and Write – read, write, and edit permissions.
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5. Users that have been assigned to the project within a Group have the Can Read permission in
the Edit Model Group Permissions dialog box.

l User Groups that display the project permissions are currently only set at the project level.

6. Use the Account Manager dialog box to reference the users assigned to Groups in specific
projects.

l For more information on the Account Manager dialog box, reference the Managers Users
and Manage User Groups topics.

7. Set the permissions for the selected group or user.

8. Log in as the specific user or group to publish a model.
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LESSON 4 REVIEW

1. In the Project Structure tree, groups can only be created before model streams are
added.

a. True

b. False

2. Once a group name has been created, it cannot be edited or renamed.

a. True

b. False

LESSON 4 SUMMARY

As a result of this lesson, you can:

l Navigate the project structure panel
l Create and delete model stream groups
l Change active model stream revision and revise model stream revision
l Disable and remove model streams
l Add model streams from other projects
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5 . 1 V IEWER INTERFACE

The Viewer interface (Workspace) is highly configurable. Tools and panels are accessed through a
series of menus located across the top of the application and a notification panel located across the
bottom of the application.

Panels can be opened, closed, rearranged, and docked into various configurations. Move, dock and un-
dock panels by dragging the panel title bar.

Hold Ctrl before dragging a panel to prevent it from docking automatically.

l Some Panels have multiple areas, differentiated with tabs:
l When panels are docked on top of one another, each panel is represented as a tab
l Tabs can be on top, side of, and bottom of a panel
l Select the tab to activate a specific panel or area of a panel
l The active panel tab is highlighted in orange
l Re-size undocked panels by clicking and dragging the panel edge
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l Resize a docked panel by clicking and dragging the edge of the panel

5 .1 .1 DOCKING PANELS:

l While moving a panel to dock at the Top, Bottom, Left or Right, the Viewer will respond by
indicating a space for the panel to be docked
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l Panels can be docked at the Top, Bottom, Right, and Left of the viewer

l Panels can be docked on top of one another
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l Panels can be docked at the top or bottom of another panel

l Panels can be docked beside another panel
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l Panels can be docked in between two panels

l Panels can be stand alone on the same or different monitor
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5 . 2 SHOW MODEL SPOTS

Model Spots provide the ability to easy find those model streams that are not aligned on the same
coordinate.
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5.2 STEP BY STEP 1 — SHOW MODEL SPOTS

1. Select View > Show Model Spots.

2. Zoom out until red dots are visible or click the Home key on the keyboard.
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3. Hover over a dot to see the model stream name(s).

4. Double-click on a model spot to zoom into the model stream(s).

5 . 3 NAV IGAT ION

InEight Model allows you to move through, zoom, pan, and change perspectives within the 3D space
surrounding your model. To begin, load or open a model. The navigation widget will appear in the top,
right corner of your window and will rotate as you navigate to indicate your camera’s position and
direction in space.

If the navigation widget is not present in the top, right corner of your screen, there is
nothing to navigate; load a model.
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In InEight Model, the viewer interaction is focused on the center of the view and not the model
objects. This allows you to see all objects from your camera perspective as you navigate and interact
with objects. To quickly return to the designated “home” view of a model, you can navigate up to the
menu, click View, and select Home Position from the drop-down menu.

Function Action Description

Orbit Left click and hold to revolve around, or
orbit, the object or model

Pan
Right click and hold to maintain the
object’s position while moving, or
panning, your view of the object or model

Navigation Controls
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Function Action Description

Zoom (to Center of
view)

Scroll the wheel away from you to zoom
in and toward you to zoom out

Zoom to Cursor

Hold the CTRL key and use the scroll
wheel to zoom to, and away from, the
cursor. Your cursor must be over a
model element

Zoom to Object / Set
Center

Double left click an object to zoom the
camera to an object. This will set the
center of orbit to the object

Zoom to Selected
Objects

Select an object and press the F5 key to
zoom the camera to frame the selection

Zoom to Home
Position

Use the Home key or double click the
mouse wheel to zoom the camera to
frame the extents and home position of
the 3D environment

Navigation Controls (continued)
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Function Action Description

Orthographic
& Perspective
Views

Toggle between the Orthographic and
Perspective view modes

Camera Settings
(Perspective View)

Camera Settings enable you to change
the focal length of the lens through which
you are viewing the model . Right click on
the camera icon and click Camera
Settings Panel to adjust your setting. This
setting is only available in Perspective
View

5.3.0 .1 FIRST PERSON NAVIGATION

First person navigation positions the camera view where it assumes your eyes would be and
what they would see in relationship to the model environment.

First Person Toggle

Navigation Controls (continued)
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Function Action Description

Walk Speed
Walk Speed enables you to change the
speed up or slow down when walking
through the model

Navigation Controls (continued)

5 . 4 SELECT ION

InEight Model allows you to manipulate the way you view, manage, and interact with the objects that
make up your model(s). Many of these features are available as hot keys and within a drop-down
menu.
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Function Action Description

Select Object

OR

Allows you to select an object

Select Object
Transparent

Allows you to select transparent
objects

Select Style
Provides a means to select like objects
with the same style (enabled only if
one object is selected)

Selection Controls
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Function Action Description

Add / Remove to
Selection

OR

Adds unselected objects to the current
selection set, or, removes selected
objects from the existing selection set

Window Selection

OR 

Selects objects completely within the
window

Selection Controls (continued)
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Function Action Description

Crossing Selection

OR

Selects objects that are both
completely in the window and those
that cross into the window

Select All
Initiates the select all action. A dialog
box will appear to confirm this action

Selection Controls (continued)
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Function Action Description

Invert Selection Inverts the selection set of objects

Restore Previous
Selection

Restores the selection set to the
previous selected objects

Selection Filter
Opens the Selection Filter dialog box
and allows you to filter down the
selection set

Clear Selection Clears the current selection

Select Related Tag
Provides a means to select like objects
with the same tag

Selection Controls (continued)
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Function Action Description

Copy Selection to
Clipboard

Provides a means to copy the select
object's metadata to the clipboard

Selection Controls (continued)
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Function Action Description

RCM - Select
Object

Right click on top of an object,
then click Select Object

RCM – Select
Related Tag

Provides a means to select like
objects with the same tag.

RCM – Select
Style

Provides a means to select like
objects with the same style.
(Note: enabled only if one
object is selected)

RCM – Add
Object to
Selection

Right click on top of an object,
then click Add Object to
Selection

RCM – Select
Objects
Contained in
Selection

Provides a means to select all
objects contained within the
object

RCM – Select
Objects
Intersecting
Selection

Provides a means to select all
objects inside and intersecting
with an object

RCM – Copy
Selection to
Clipboard

Provides a means to copy the
selected object’s metadata to
the clipboard

Right Click Menu Selection Controls

5.4 .0 .1 RIGHT CLICK MENU

l The Selection Menu offers all the selection commands listed in the table above, except
Delete Selected Objects and Copy Selection to Clipboard (see the table above for
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descriptions)

l The Show/Hide Menu offers even more options – many of which are also accessible as hot keys.
See the table below for descriptions
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Function Action Description

Isolate Mode Toggles between the entire model
and an isolated view of the
selected objects

Show Selected Shows all selected objects

Hide Selected Hides all selected objects

Hide Unselected Hides all unselected objects

Hide Models from
Selected

Hides all models from the selected
objects

Model Object View Controls
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Function Action Description

Hide Models from
Unselected

x

x

Hides all models from the
unselected objects

Show All Shows all objects and models in a
project

Undo View State
Changes

Undo up to the last 10 view state
changes

Redo View State
Changes

Redo up to the last 10 view state
changes

Toggle Full Screen Toggles the window size and
position between a customizable
(F11) and full screen window

Model Object View Controls (continued)
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Function Action Description

Show Model Spots Marks the model’s spot within the
space so that the model is
identifiable no matter how far out
you zoom

Model Object View Controls (continued)

5 . 5 SELECT ION MODE

Selection Mode provides the ability to select objects related to the active mode.

• Last Object will select the lowest level of an object (a child)

• First Object will select all objects that belong to the highest level (a parent)

• IWP will select all objects that belong to the IWP associated to the object being selected

• CWP will select all objects that belong to the CWP associated to the object being selected

• Elements will select objects that belong to the Element associated to the object being selected

• Tag Name will select objects that belong to the Tag associated to the object being selected

Any object can be selected no matter what mode is active. If the object selected does not
have data associated to it for the active mode, then the Last Object mode will be the
default.
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5 .5 .1 SELECTION MODE INDICATOR

Selection Mode is always active and will be displayed at the bottom right within the viewer.

5 .5 .2 SELECTION MODE - LAST OBJECT

Last Object selection mode will select the lowest level of the object.

5 .5 .3 SELECTION MODE - F IRST OBJECT

First Object selection mode will select the highest level of the object and select all objects associated to
the parent level.
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5 .5 .4 SELECTION MODE - IWP

IWP selection mode will select all objects that belong to the IWP associated to the object being
selected.
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5 .5 .5 SELECTION MODE - CWP

CWP selection mode will select all objects that belong to the CWP associated to the object being
selected.
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5 .5 .6 SELECTION MODE - ELEMENT

Element selection mode will select all objects that belong to the Element associated to the object
being selected.

InEight Inc.  |  Release 24.9 Page 135 of 558

Model User Guide 5.5 Selection Mode



5 .5 .7 SELECTION MODE - TAG

Tag selection mode will select all objects that belong to the Tag associated to the object being
selected.
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5 . 6 HOT KEYS

Click to open a one page PDF copy of the InEight Model Hot Keys.

Function Action Description

Orbit Left click and hold to revolve
around, or orbit, the object or
model

Viewer Navigation

InEight Inc.  |  Release 24.9 Page 137 of 558

Model User Guide 5.6 Hot Keys

InEight Model HotKeys.pdf


Function Action Description

Pan

Right click and hold to
maintain the object’s
position while moving, or
panning, your view of the
object or model

Zoom (to center of view) Scroll the wheel away from
you to zoom in and toward
you to zoom out

Zoom to Cursor

Hold the CTRL key and use
the scroll wheel to zoom to,
and away from, the cursor.
Your cursor must be over a
model element

Zoom to Object / Set Center Double left click an object to
zoom the camera to an
object. This will set the center
of orbit to the object

Zoom to Selected Object

Select an object and press
the F5 key to zoom the
camera to frame the
selection

Viewer Navigation (continued)
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Function Action Description

Zoom to Home Position Use the Home key or double
click the mouse wheel to
zoom the camera to frame
the extents and home
position of the 3D
environment

First Person Toggle

Adjust Walk Speed Walk Speed enables you to
change the speed up or slow
down when walking through
the model

Viewer Navigation (continued)
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Function Action Description

Select Object

OR

Allows you to select an
object

Select Transparent Object
Allows you to select
transparent objects

Add / Remove to Selection Adds unselected objects to
the current selection set, or,
removes selected objects
from the existing selection
set

Model Object Selection
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Function Action Description

OR

Window Selection

OR 

Selects objects completely
within the window

Crossing Selection Selects objects that are both

Model Object Selection (continued)
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Function Action Description

OR

completely in the window
and those that cross into the
window

Select All
Initiates the select all action.
A dialog box will appear to
confirm this action

Invert Selection Inverts the selection set of
objects

Model Object Selection (continued)
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Function Action Description

Restore Previous Selection
Restores the selection set to
the previous selected
objects

Selection Filter Opens the Selection Filter
dialog box and allows you to
filter down the selection set

Clear Selection Clears the current selection

Model Object Selection (continued)

Function Action Description

Isolate Mode Toggles between the entire
model and an isolated view of
the selected objects

Model Object View
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Function Action Description

Show Selected Shows all selected objects

Hide Selected Hides all selected objects

Hide Unselected Hides all unselected objects

Show All Shows all objects and models
in a project

Show Model Spots
Marks the model’s spot within
the space so that the model is
identifiable no matter how far
out you zoom

Model Object View (continued)
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Function Action Description

Toggle Full Screen Toggles the window size and
position between a
customizable (F11) and full
screen window

Model Object View (continued)

Function Action Description

Selection Information Opens the Selection
Information Panel where you
can view the attributes and
metadata of your selected
objects

Master Presets Opens the Master Presets
Panel where you can
quickly select or create a
master preset

Coordination Opens the Coordination
Panel where you can quickly
run rules and see your
results

Panels
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Function Action Description

Data Transformation
Operations

Opens the Data
Transformation Operations
Panel

Panels (continued)

Function Action Description

Tag Selected Opens the Tag Panel to
allow you to select and apply
tags to your selected objects

Actions

Function Action Description

Load Project

Opens the Load Model
Project Dialog Box where
you can quickly load
additional models

Other
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Function Action Description

Command History

Opens the Command
History Panel where you can
view any and all saved
changes

Other (continued)

5 . 7 USER SETT INGS

Within the Settings icon in the top left of the menu bar, a user can modify their user settings. Toggle
to:

l Work Online/Offline
l Adjust User Settings
l Change Password
l Edit Contact Information
l Save Workspaces
l Reset Workspace
l administrators can access User Management through Admin
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5 .7 .1 SETT INGS. . .

Provides the ability to change:

l Mouse/Keyboard Mapping changes
l Choose Default Zoom Behavior
l Set the Coordinate Display Units
l Change the Background Color
l Choose Selection Display Style
l Invert Scroll Wheel in First Person

5 .7 .2 MOUSE / KEYBOARD MAPPING

Allows for the user to change any of the shortcuts to their working experience desire
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5 .7 .3 CHOOSE DEFAULT ZOOM BEHAVIOR

Allows for the user to set Zoom to Center or Zoom to Cursor.

InEight Inc.  |  Release 24.9 Page 149 of 558

Model User Guide 5.7 User Settings



5 .7 .4 COORDINATE DISPLAY UNITS

Allows for the user to set the coordinate display units. This does not change the scale of the model.
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5 .7 .5 BACKGROUND COLOR

Allows for the user to change the background color of the 3D viewer.
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5.7.5 .1 CHOOSE SELECTION DISPLAY STYLE

Allows for the user to manage display of selected objects. Manage the ability to show lines (edges) of
the objects in a desired color and the ability to color selected objects with a fill color.

Choose Fill Color… also has transparent settings.

5 .7 .6 INVERT SCROLL WHEEL IN F IRST PERSON

Allows for the user to manage the "head tilt" within the First Person.
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5 . 8 CREATE NEW MARKUP

A new markup can be created within the viewer and saved to a PDF file. Access it through View ->
Create New Markup. Once Create New Markup is selected, a snapshot of the current 3D Viewer is
captured and ready for a markup.
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The markup capabilities allow the user to place Arrows, Scribble, Ellipse, Rectangles, and Text.

The text size can be adjusted with the Thickness bar.

l Set the Color, Thickness and line type to a Solid or Dashed before placing an object
l Once objects are placed, they cannot be edited. They can, however, be deleted by
selecting the object, then select the DEL key on the keyboard.

l Text color and size can be edited after placement. Select and highlight the text, then select
edit color and/or move the thickness bar to change the text size.

Select Save to… to save the markup as a PDF file.
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Once the new PDF file is saved, the existing markup is still active.

Select Clear Markups to clear all markups.

Select Back to Model to toggle from the New Markup to the 3D Viewer

Select the red X to close the Markup tool.

5 . 9 GR IDS

If grids are part of the Revit project, then they are included in the export process.
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Grids can be toggled on and off through the main menu. Use the following step by step to toggle the
grids on or off.

5.9 STEP BY STEP 1 — TOGGLE ON OR OFF GRIDS

1. From the main menu, click View.

2. Select Show Grids.

Grids can also be toggled on and off from the notification panel at the bottom left in the application.
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LESSON 5 REVIEW

1. How can you navigate in InEight Model?

a. Using your mouse

b. Using the Navigation Widget

c. Using hot keys

d. All of the above

2. If you right click on your mouse, what two menus appear?

a. Trash, Model settings

b. Plugin History, Show/Hide

c. Show/Hide, Selection

d. Selection, Trash

3. You can navigate a model from a First Person View.

a. True

b. False

LESSON 5 SUMMARY

As a result of this lesson, you can:

l Navigate InEight Model
l Select model objects
l Use common hot keys
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6 . 1 COMMAND H ISTORY

As content is added to the model environment, a complete history is tracked, saved, and accessible
anytime through the lifetime of the project. The Command History panel provides the insight as to
what actions have been taken before they have been saved to the project.

The Command History panel is located from the main menu, Edit -> Command History or with the
Ctrl+H hotkey.

As changes are created within the model environment, they are listed in the Command History until
the user saves the changes to the project. Also, there will be an * following the project name to
indicate that there are changes.

You can undo any changes by selecting a previous change or selecting <empty>. Notice that the project
name no longer has an * following the name.
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To reactivate the changes, simply select on the last change that you want applied to the project. Then
Save the changes to the project with Ctrl+S or select File -> Save Project…

The Save Changes dialog box will open with a description of the project changes.

6 . 2 PROJECT UPDATES

When a user has saved updates to the project each user currently within the project will get a notice:
You have project updates.
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Right click on the green sync icon and select Update Now to retrieve the latest project updates.

Or select Project Updates Panel to review the Update Details and by who. Once reviewed, then click
Update Now to update your current session with the latest project updates.
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If there are and a user tries to save their project changes, then a Project Not Current dialog box will
appear, requiring the user to perform a project update before a project save can take place.

6 . 3 PROJECT H ISTORY

Project History allows users to view a project at any stage, from the beginning all the way to the end of
a project.

The Project History panel is located from the main menu, File -> Project History or with the
Ctrl+Shift+H hotkey.
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The Project History panel provides the ability to look at the project in a historical view. This can be
achieved by:

l Jump to date and then click Go
l Project Revisions – search revisions made by a particular user or search for keywords from
the Revision Notes history.
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l Revision Date – double click on a revision date

When an older revision is activated, a red box will appear around the 3D Viewer and the project will be
rolled back to that particular time in the project’s history.
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In order to get back to the current version of the project, double-click on the first date
listed at the top of the Revision Date list. Once the model is back to the current version,
the red box will disappear.
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LESSON 6 REVIEW

1. Once you've made a change in model, the previous state can never be recovered.

a. True

b. False

2. Users cannot save changes to their project if a project update is available.

a. True

b. False

LESSON 6 SUMMARY

As a result of this lesson, you can:

l Access and review your model's history
l Understand how to update your project from the Project Update window
l Access the history of the commands taken on your project prior to saving Access and
review
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7 . 1 TAGS AND OBJECTS  OVERV IEW

Tags are the organizational structure of model objects and define a set of identifiers (category and
value). When you export a model through Revit or AutoCAD, or import an IFC file, you are creating tags
and objects metadata.

Interact with tags to manipulate your model in a variety of ways, including: 

l Selecting a group of model objects
l Visualizing your model with styles associated to tags
l Creating custom tags to enhance a model's value
l Linking documents and photos to tags
l Creating coordination rules to detect clashes

7 .1 .1 TAGS AND OBJECTS PANEL

To access your project's tags and objects, select View from the menu bar at the top of the screen.
Then, select Tags and Objects.

l This will launch the Tags and Objects panel

7.1.1 .1 OBJECTS TAB

The Objects tab within the Tags and Objects panel displays all the model streams that are available
within your project.
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Search for objects in the search bar or use auto-scroll to expand the list of tags that relate to your
selected model object(s).
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7.1 STEP BY STEP 1 — TOGGLE MODEL STREAMS VISIBILITY

1. From the Tags and Objects panel, select the Objects tab.

2. Toggle the View check box to turn the visibility of Model Streams on or off.

7.1.1 .2 TAGS TAB

The Tags tab displays all the tags imported with the model streams and any dynamic or custom tags
created.

InEight Inc.  |  Release 24.9 Page 173 of 558

Model User Guide 7.1 Tags and Objects Overview



Select a tag category to expand its list of tag values or use the search bar to find a tag.
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7 . 2 CREATE AND ED IT TAGS

Tags are fixed, or static, values within a defined category that help describe the objects to which they
are assigned. You can only associate a model object to one Tag Value within a Tag Category. Create
tags through the Model Exporter/Importer, manually in InEight Model or import tags from Excel. Use
tags to help define and view your model through different lenses.

7 .2 .1 MANUALLY CREATE AND EDIT CUSTOM TAGS

Use custom tags to transform design models into construction models or owner models.

Add custom tags to:

l Normalize data to your specific nomenclature
l Unique Identifications
l Status
l Endless possibilities…
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7.2 STEP BY STEP 1 — CREATING TAGS

1. From the Tags and Objects panel, select the Tags tab.

2. Next, select the Add icon.

If there are model objects selected, Ctrl+T will open the Tag dialog box.
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3. The Tag dialog box will open. Enter a tag category name and select Add New.

l Once you select Add New, the new Tag Category is created and selected

If you select OK without first selecting Add New, you will close the Tag dialog box
without saving your tag category name.
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4. Enter a tag value and select Add New.

5. Now, select OK to save your new tag(s).
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If any model objects are actively selected, a note will appear in the Tag dialog box
asking you to confirm that you want to apply your tag to those selected objects.
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6. Your new tag will appear in the Tag panel.

7 .2 .2 DELETE A TAG

Any tags from the Model Exporter / Importer process deleted are not really deleted. They are still in
the database but hidden from the Tag panel. The next Model Exporter / Importer process will not
import any tag that has been deleted.
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7.2 STEP BY STEP 2 — DELETING TAGS

1. From the Tags and Objects panel, select the Tags tab.

2. Select the tag category or tag value(s) you want to delete, then click on the Delete icon.

7 . 3 CREATE AND ED IT DYNAMIC  TAGS

Unlike static tags, dynamic tags are controlled by rule sets. They are powerful tools in creating custom
groups of objects for various interactions. Use Dynamic tags to configure coordination rules and
normalize data.
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7.3 STEP BY STEP 1 — CREATING DYNAMIC TAGS

1. Open the Tags and Objects panel.

2. Check that no model objects are actively selected.

3. Select the Add icon to open the Tags dialog box.

4. Select the Dynamic tab.
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5. Enter a name and select a category from the drop-down menu or select New....

6. Select either ANY or ALL from the drop-down menu.

ANY includes any object from ANY of the tags selected.
ALL includes objects that have ALL of the tags selected.

7. From the existing tags list on the left, select the tag(s) you want to include.
l Use the top arrow to direct that tag from the existing options to your dynamic tag
inclusion list on the right. Repeat until you have moved all desirable tags to the
included list on the right
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Existing Tags can be multi-selected by holding CTRL or SHIFT keys on the
keyboard.

8. From the existing tags list on the left, select the tag(s) you want to exclude.
l Use the bottom arrow to direct that tag from the existing options to your dynamic tag
exclusion list on the right. Repeat until you have moved all undesirable tags to the
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excluded list on the right

The same tag cannot exist in both the included and excluded fields.

9. Preview the results of your dynamic tag by selecting the Preview icon.
l This will select all model objects that meet the Dynamic Tag criteria
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10. To save this dynamic tag, select OK.

Dyanmic tags will not appear in the Existing Tags Column, and therefore cannot be
used in another dynamic tag.

Within the Tags and Objects panel, under the Tags tab, Dynamic tags appear in
italics.
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7.3 STEP BY STEP 2 — EDITING A DYNAMIC TAG

1. Open the Tags and Objects panel.

2. Select the dynamic tag you want to edit. Select the Edit icon or right click and select Edit
Dynamic Tag from the drop-down menu.

7 . 4 ASS IGN AND  REMOVE TAGS

7 .4 .1 ASSIGNING TAGS

Assign custom created tags to model objects to enrich the model with actionable metadata.

7.4 STEP BY STEP 1 — ASSIGNING TAGS

1. Select desired model objects.

2. Use the Tags hot key Ctrl + T, or right click to view the Selection Menu.
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3. From the Selection Menu, click on Tag Selected Objects.

4. From the Tags dialog box, select a tag category and value(s) you wish to apply to your selection.
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5. Click OK.

Clicking OK will apply the selected tag to the actively selected objects.

If the desired tag category or value is not available, then simply create it, then
select OK.

7 .4 .2 REMOVING TAGS

Quickly remove tags from model objects.

7.4 STEP BY STEP 2 — REMOVING TAGS

1. Select desired model objects.

2. Right click to view the Selection Menu.
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3. From the Selection Menu, select the tags you want to remove from your selected objects.

7 . 5 COPY METADATA FROM MODEL TO EXCEL

Metadata can be copied from your model into Excel by selecting the whole model or specific parts of
the model, copying that data to the clipboard, and then pasting that data into excel.

The following step-by-step walks you through how to copy metadata from Model to Excel.
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7.5 STEP BY STEP 1 — COPY METADATA FROM MODEL TO EXCEL

1. Select model objects.

2. Right-click anywhere in the viewer and select Selection > Copy Selection to Clipboard.
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3. Open Excel, and then paste the copied items.

All metadata associated with the selected objects is now pasted into Excel.

7 . 6 TAG DATA EXPORTER

The Tag Data Exporter provides the ability to identify a Tag to pivot off of. It also lets you identify your
desired related tags to include in an export of model metadata into a CSV file. The configurations can
be saved for repeatable use. These configurations can also be imported and exported as needed for
other projects.

7.6 STEP BY STEP 1 — EXPORT TAG DATA TO CSV FILE

1. Right-click the Tags tab in the Tags and Objects panel.

2. Select Tag Data Exporter....

3. Select a Tag, and then move it to the Identifier/Pivot Tag field.

Page 192 of 558 InEight Inc.  |  Release 24.9

7.6 Tag Data Exporter Model User Guide



4. You can be specific with the Tag values by removing any values that you do not want to be
a part of the export. Select the tag values, and then click Remove .
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5. You can also be specific with the Tag values by selecting your values, and then moving
them into the Identifier/Pivot Tag area.
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6. Select additional Tags, and move them to the Tags to be exported field.
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7. Enter a Configuration Name and click Save to access this configuration again.
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8. The saved configurations can be imported, exported, and deleted.

9. Toggle the Include Objects Column if you want the data exported to be combined into like rows
according to the data with a leading column providing a count of objects meeting that row of
data.
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10. Click Export All… to export all data related to the configuration into a CVS file.

11. Click Export… to only export data related to the configuration and the model objects currently
selected.

l CVS file with the Object Column

Page 198 of 558 InEight Inc.  |  Release 24.9

7.6 Tag Data Exporter Model User Guide



l CVS file without the Object Column

7 . 7 IMPORT TAGS FROM EXCEL

Custom Tags can be imported from Excel into the model.

Within Excel, one column needs to contain a unique tag for the Category Tag / Category Values that
exist within the model.

Assign custom created tags to model objects to enrich the model with actionable metadata.
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7.7 STEP BY STEP 1 — IMPORT TAGS FROM EXCEL

1. Establish Unique ID information within excel. (i.e., Asset_ID in column A.)

Asset_ID has to be an existing Tag Category along with the information in cells A2
thru A20 must be existing Tag Values within the model.

Asset_ID cannot have any duplicates.

Model Objects must be assigned to the Unique ID.
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2. Establish metadata to import into the model. (i.e. Installation Status in column B)

3. Select the InEight tab within the Excel ribbon.
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4. Select a cell within the Unique ID column.

5. Within the Actions menu, select Set ID Tag.

The Set ID Tag will change from <none> to the column header. (i.e. Asset_ID)
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6. Select a range of cell(s) within the column of data to import.

7. Within the Actions menu, select Bulk Assign Tags.
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8. Import multiple columns of metadata, by selecting a range of cells that span columns.

9. Within the Actions menu, select Bulk Assign Tags.

There will be NO indication notice that the data has been imported.
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10. Results:

7 . 8 SELECT MODEL OBJECTS V IA EXCEL

Model objects can be auto-selected and framed in the model viewer by selecting tag values in Excel. In
Excel, the top row represents the Tag Category. Any row below the top row represents the Tag Value.
The Tag Category and Tag Value must be exactly the same in Model in order for Excel to interact with
Model.

The following step-by-step walks you through how to auto-select Model objects in Excel.

The following steps require the Excel Plugin to be installed.
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7.8 STEP BY STEP 1 — SELECT MODEL OBJECTS VIA EXCEL

1. From Excel, select the InEight tab from the top menu.

2. Under the Project section, Click Login.

The Login to InEight dialog box opens.

3. Login using the same credentials for InEight Model.

4. Select the project you are currently in, and then click OK.

5. In Excel under the InEight tab in the Modifiers section, select the check marks for both Auto
Select and Frame Selected.

6. Select a tag value from the metadata copied from the Model into Excel.

7. In the Actions section, click Select Tag.
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7 . 9 CREATE TABLES OF EXTERNAL DATA

Only a Project Admin can create Generic Tables to import external data and link to a
Unique ID Tag in Model.

External information can be accessed in Model but is managed externally using Excel.

7 .9 .1 IDENTIFY THE MODEL UNIQUE ID

The following step-by-step walks you through how to identify the model Unique ID in Excel.

The following steps require the Excel Plugin to be installed and for a Project Admin to be
logged into the InEight Excel Plugin.
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7.9 STEP BY STEP 1 — IDENTIFY THE MODEL UNIQUE ID

1. After you log into Excel, use the first column (cell A1) to match a Tag Category in Model.

Columns B and beyond can contain additional columns of data as needed.

2. Rename the Tab to the preferred Table Name.

Although this is not a required step, it can provide clarity as you develop the extra data.

3. Under the InEight tab in the Data section, select Table.

4. From the drop-down menu, in the New Table section, select Create new Table.
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5. From the Create new Table data box:

a. Select the check mark for Use headers from current Excel worksheet.

b. Confirm the Schema Name is labeled with the preferred name with no spaces.
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c. Select Generic Table for the Table Type.

6. Select one item to be the Identifier (i.e. 00 – Asset).

This must be a pre-existing Tag Category in Model.
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7. In the Data Type column, choose the correct Data Type for each Column Name.

All data types are defaulted to Short String.

l String: can contain any sequence of characters

l Integer: a whole number (not a fractional number) that can be positive, negative, or zero (-
5, 1, 5, 8, 97, 3243)

l Location: GPS latitude and longitude coordinates

l Short String: can contain any sequence of characters limited to 32 characters

l If this is chosen, make sure that your data will not extend beyond 32 characters or
you will encounter an error when uploading data.

l TimeStamp: a seven part value representing a date and time by year, month, day, hour,
minute, second
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l GUID: Global Unique ID

l Unsigned Integer: often called units which are zero or positive numbers

l Long Integer: longer than an integer

l Float: a number that is not an integer, because it includes a fraction in decimal format

l Double: can represent a fractional and whole values and can use exponential notation
(1.0e6 to represent one million)

You can add or remove any of the column name fields.

8. After all Column Name fields have the preferred Data Type, select OK to create the Generic
Table.

The new tab is then shaded in red to showthat it is now a table available in the Model database.

Three new fields also show: Created By, Created On and Property ID.

7 .9 .2 ADD INFORMATION TO GENERIC TABLE

The following step-by-step walks you through how to add information to the generic table.

7.9 STEP BY STEP 2 — ADD INFORMATION TO GENERIC TABLE

1. Open Excel and log in.

2. Under the InEight tab in the Data section, select Table.

3. Under Existing Table, select the name of your newly created Generic Table, and then select
Query All.
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4. In the Identifier column or the Unique ID, fill in the data from the model.

The new information is then highlighted in yellow. This shows that the information has been
added or modified but not yet saved to the database table.

5. Under the InEight tab in the Settings section, click Pending Changes.

6. Click Publish.
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The database table is now updated.

7. Fill in any additional data throughout the project as needed.

7 .9 .3 IMPORT INFORMATION TO GENERIC TABLE

The following step-by-step walks you through how to import information into the generic table.

7.9 STEP BY STEP 3 — IMPORT INFORMATION TO GENERIC TABLE

1. Open Excel and log in.

2. In Excel, select the spreadsheet tab containing the preferred data that needs to be uploaded into
a table.
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3. Under the InEight tab in the Data section, select Import.

4. In the Import Records dialog box, select the Table schema that you want to upload data into.

5. When a warning dialog box appears, select OK.

The Generic table opens with the new data added.

6. Under the InEight tab in the Settings section, select Pending Changes.

7. Click Publish.

The database table is now updated.

7 .9 .4 REFRESH EXIST ING TABLE DATA

Throughout the project, data might be updated by another user without notification that an update is
happening. You need to refresh your table to see new information.

The following step-by-step walks you through how to refresh existing table data.
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7.9 STEP BY STEP 4 — REFRESH EXISTING TABLE DATA

1. Open Excel and log in.

2. Under the InEight tab in the Data section, select Table.

3. Under Existing Table, select the name of your newly created Generic Table, and then select
Query All.

7 .9 .5 CLOSE DATABASE TABLES

The following step-by-step walks you through how to close database tables.
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7.9 STEP BY STEP 5 — CLOSE DATABASE TABLES

1. Open Excel and log in.

2. Right-click the Excel spreadsheet table tab.

3. Select Delete.

Deleting the table tab only removes the local worksheet from Excel, but it does not remove
database tables from your project.

You can also click the x in the top right of Excel. The InEight Excel Plugin dialog box opens
showing available options.
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LESSON 7 REVIEW

1. How can you create Tags in InEight Model?

a. Manually create from Tags and Objects panel

b. Automatically create tags from the metadata of the Export / Import process

c. Manually import tags from an Excel file

d. All of the above

2. Tags are made up of what two components?

a. Category, Size

b. Size, Value

c. Value, Location

d. Category, Value

3. Deleting a tag that was created through the export / import process does not delete
the tag until the nexttime you export / import to revise or update your model.

a. True

b. False

LESSON 7 SUMMARY

As a result of this lesson, you can:

l Create and edit static tags
l Create and edit dynamic tags
l Assign to and remove tags from objects
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CHAPTER 8 — DATA
TRANSFORMAT ION OPERAT IONS

8 . 1 DATA TRANSFORMAT ION OPERAT IONS
(DTO) OVERV IEW

DTOs provide flexible and repeatable processes to maintain, normalize, add, validate, parse, and
concatenate data. DTOs can be exported and imported from project to project to eliminate duplicate
effort.

You can access DTOs from the main InEight Model window. Click Logic > DTO.

The Data Transformation Operations window has three tabs:

l DTO – Lets you create a tree structure of DTOs.

l Selector - You can select model objects from tags and object properties using specific criteria.

l Action – Lets you create, parse, concatenate, and quantify model data, and more through
various functions.



8 .1 .1 DTO TAB

1 Action icons provide one-click actions for the most common DTO functions. You can add,
add group, export, import, duplicate, and delete.

2 The list view lets you enable or disable DTOs, create DTOs, and view the list grouped by
folders.

3 The log view shows the interaction information of DTOs when they are used. The
Maximize/Minimize icon opens or closes the DTO Log panel. You can use the delete icon
to clear the log.

4 Bottom action buttons let you run the selected DTOs or selected DTO groups, run all
enabled DTOs. Test your included model objects in the Selector tab criteria.

5 You can use the Expand Panels icon to view all three tabs at the same time or view one
tab at a time.
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8 .1 .2 SELECTOR TAB

Rule Type Select Tag or Object Property.

Tag/OP
Name

Select a Tag or OP Name

Operator Select the operator rule.

Value Select a value from the tag or object property identified in Tag / OP Name
field.

Exclude Exclude the children or parent model objects, or you can ignore using the none
value.

After you click the Test button, you can review and validate your selection criteria in the Selection
Information panel.
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8 .1 .3 ACTIONS TAB

Action Select between multiple action types that include Tag, Temp Property, Calculated,
Quantity, Elements, and Sequential Tags.
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Tag
Name

Enter a new unique tag name or select an existing tag name.

Tag
Value

Enter the new value that you want to associate to the Selector tab criteria.

The available fields change depending on the action you select.

8 . 2 MANAGE DTOS

In the DTO tab, you can add DTOs manually. First you must create a DTO group, and then add DTOs to
the group. DTOs can also be imported and exported between projects to save you time.

8 .2 .1 DTO TAB

ADD A DTO GROUP FOLDER

1. In the DTO tab, to Add a DTO group, click the Add Group icon.

2. You can add notes for the DTO group. Double-click the Notes section to add your notes.
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ADD A DTO

1. Select a DTO group, and then click the Add DTO icon. You can also right-click in the DTO group to
add a DTO.

2. You can add notes for the DTO. Double-click in the Notes section to add your notes.
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RENAME A DTO

You can rename DTO groups and DTOs to better communicate their purpose.

1. Click the DTO tab

2. Double-click the DTO Group or DTO, and then enter the new name. You can also right-click the
Name column and use the menu.

3. Click Save.

8 .2 .2 SELECTOR TAB

After you create a DTO, you can create rules in the Selector tab to build your own criteria to find
specific model objects using their tags or object properties.

CREATE A RULE

1. In the DTO tab, click your DTO to select it.

2. Click the Selector tab. You can see your DTO name as a reference. By default, a blank Rule row is
created.
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3. Fill in the rule information to identify all foundations in the model.

a. Rule Type

b. Tag / OP Name

c. Operation

d. Value

e. Exclude

4. Click Test to select all objects that meet the criteria.
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After you click Test, you can review and validate your selection criteria in the Selection
Information panel.

ADD ADDITIONAL RULES TO FILTER FOR OTHER METADATA

1. Click the Add icon below the current rule.

2. Use the and/or toggle to switch between the two options. The ribbon changes color depending
on the option.

3. Fill in your rule criteria.

4. Click Test to select all objects that meet the criteria.
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You can review and validate that you have selected the objects as expected in the Selection
Information panel.
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8 .2 .3 ACTIONS TAB

CREATE A NEW TAG

1. Click the Actions tab. The action window shows the DTO name and by default, creates a blank
row for you to fill in.

2. Fill in the criteria.

3. Enter the tag name and tab value.

4. Click Run selected to execute the DTO and create your tag.
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o You can expand the DTO Log panel to view information about the executed DTO.

5. Click Save.
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1 . 1 DTO EXAMPLES

1 . 2 CLEAN UP AND NORMAL IZE MODEL DATA

DTOs provide flexible and repeatable processes to clean up and normalize model data. Clean up and
normalizing data includes grouping the data from multiple models into a tag, grouping similar models
into a single tag, converting dimensional text data into a number, and converting lengths such as
inches to feet using tags and object properties.

For additional information on tags go to Tags and Objects.

The following examples show you how you can use tags and object properties to clean up and
normalize data.

1 .2 .1 GROUP SIMILAR MODELS INTO A TAG

When you have multiple models in your project that have many differences, you can create tags that
combine similar models for easier and faster accessibility.

You can group models that contain Garage into a tag named Garage. Tags such as Office 1, Office 2,
and Garage can be used.

https://learn.ineight.com/Model/Content/11_Tags_and_Objects/0_TagsAndObjectsStart.htm


GROUP SIMILAR MODELS INTO A TAG

1. Add a DTO group and name it Normalize.

2. In the group, add a DTO and name itModel Group – Garage.
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3. In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name Model

Operator contains

Value Garage

4. Click the Test button to review and validate your selection criteria in the Selection Information
panel.

5. In the Actions tab use the following criteria:
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Action Tag

Tag Name Model Group

Tag Value Garage

6. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria. The results will include Tags associated with your selection as shown in the
screenshot below.

1 .2 .2 CONVERT DIMENSIONAL TEXT DATA INTO A
NUMBER

If many of the models have dimensional data in text format, as opposed to a number format, you can
normalize this into something more standard.

The model has NPD (Nominal Pipe Diameter), whereas other design applications use size. This can be
normalized into something standard.
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CONVERT DIMENSIONAL TEXT DATA INTO A NUMBER

1. Add a new DTO group in a new group or an existing group such as Normalize, and then name it
Piping.

2. Add a new DTO in the group named NPD to Size_Pipe. You can add a note in the Notes column
to communicate the purpose of the DTO.

3. In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name NPD

Operator not null
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4. Click the Add row icon below the row to add another row. Add an additional rule that will filter
for Piping:

Rule Type Tag

Tag / OP Name NPD

Operator =

Value Piping

5. Click the and/or toggle above the first rule on the top left to select and. Selecting andmeans
that both rules must apply to the model object data.

o You can click the Test button to review and validate your selection criteria in the Selection
Information panel.
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6. In the Actions tab select Calculated for Action.

7. Click the Add row icon next to Action to add a new function, and then use the following criteria:
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Function number()

Tag NPD

Position 0

The number() function will convert the text data to number data.

8. Add another function, and then use the following criteria:

Function tag()

Tag IN8_Size_Pipe

IN8_Size_Pipe is a custom tag name. You can create and give your tag a specific
name that will help you organize your data.

o In the DTO Log window, the Tag Name and Value shows the expected results after the DTO
is executed.
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9. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1 .2 .3 CONVERT INCHES TO FEET

You can use DTOs to convert units. If you have models that have piping length in inches, and you need
to convert the length to feet for take-off, you can create a DTO to convert the units.

CONVERT TEXT FORMAT TO NUMBER FORMAT

1. Add a new DTO to convert the length of piping from text format to number format. Name the
new DTO Pipe Length (in).

2. In the Selector tab use the following criteria:

Rule Type Tag or Object Property

Tag / OP Name Length

Operator not null

3. Use the and/or group toggle at the top right to select and.
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4. Click the Add group icon at the top right and include the following group criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping.nwd

5. Click the Add row icon on the bottom left, and then then use the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec UG Yard Piping_rev1.nwd

6. Use the and/or row toggle on the top left above the group rows to select or.
o The criteria selected will find all objects with a Length value. The and group toggle at the

top right means that both listed model tag groups will be included.
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7. In the Actions tab select Calculated for Action.

8. Click the Add icon next to Action to add a function, and then use the following criteria:

Function number()

Tag Length

9. Add another function with the following criteria:

Function tag()

Tag Length_Pipe (in)

10. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

CONVERT PIPING LENGTH FROM INCHES TO FEET

1. Add a new DTO, and then name it Pipe Length (ft).

2. In the Selector tab create the following criteria:
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Rule Type Tag

Tag / OP Name Length_Pipe (in)

Operator not null

3. In the Actions tab select Calculated for Action.

4. Click the Add icon next to Action to add a function, and then use the following criteria:

Function math()

Tag Length_Pipe (in)

Operator /

Constant 12

Themath() function can be used with Tags, Object Properties, and Constants.
Constant will equal type in a number as opposed to using a tag.

5. Add another function with the following criteria:
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Function tag()

Tag Length_Pipe (ft)

6. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1 . 3 IDENT IFY AND ADD ADD IT IONAL MODEL
DATA

DTOs provide flexible and repeatable processes to add additional model data. The following are
examples to show you processes to identify specific model data and add model data using DTOs.

1 .3 .1 IDENTIFY MODEL DATA

You can differentiate between above ground large bore piping (AG/LB), above ground small bore
piping (AG/SB), underground large bore piping (UG/LB) and underground small bore piping (UG/SB).
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You can add a DTO to find all large bore piping according to your standards (>2.5”). Also, create a new
tag named AG LB to find all above ground piping.

IDENTIFY AND USE AG/LB PIPING

Add a new DTO, and then name it Pipe – AG LB.

In the Selector tab create the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping

Use the and/or row toggle on the top left to and.

Click the Add row icon below the row, and then use the following rule criteria:

Rule Type Tag

Tag / OP Name IN8_Size_Piping

Operator >

Value 2
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In the Actions tab use the following criteria:

Action Tag

Tag Name IN8_PipeAG/UG_LB/SB - PowerPlant

Tag Value AG LB

Click on the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

IDENTIFY AND USE AG/SB

1. Add a new DTO to find all small bore piping according to your standards (<2”). Also, create a new
tag named AG SB to find all above ground piping.

2. Duplicate the previous DTO, and then rename the new DTO Pipe – AG SB.

3. In the Selector tab update the following criteria:

Operator <

Value 2.5

4. Leave the rest of the criteria the same.
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5. In the Actions tab use the following criteria:

Action Tag

Tag Name Model Group

Tag Value AG-SB

6. Click on the Run selected button to execute the DTO, and then create the new tag according to
your selection criteria.

If your model includes the steel members length but does not have the weight, you can calculate the
length into weight for take-off.
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ADD WEIGHT TO STEEL MEMBERS USING LENGTH

1. Add a new DTO, and then name itW Shapes in LBs.

2. In the Selector tab create the following new rule criteria:

Rule Type Tag

Tag / OP Name Revit_Family_Type

Operator contains

Value W Shape

3. Use the and/or row toggle on the top left to select and.

4. Click the Add row icon on the bottom left, and then use the following criteria:

Rule Type Tag

Tag / OP Name Length

Operator not null

Value W Shape
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1. In the Actions tab select Calculated for Action.

2. Click the Add icon next to Action to add a function with the following criteria, assuming 90 lbs.
per foot:

Function math()

Constant 90

Operator *

Tag Length

Themath() function can be used with Tags, Object Properties, and Constants.
Constant will equal type in a number as opposed to using a tag.

3. Add another function with the following criteria:

Add another function with the following criteria:

Function Tag()

Tag name Calculated Nominal Weight (lbs)
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4. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

Now that the previous DTO calculates the length of your steel members into weight in pounds, you
need to calculate the weight into tons for take-off.

CONVERT WEIGHT FROM POUNDS TO TONS

1. Duplicate the previous DTO, and then name the new DTOWeight (ton).

2. In the Selector tab create the following new rule criteria:

Rule Type Tag

Tag / OP Name Calculated Nominal Weight (lbs)

Operator not null
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3. In the Actions tab select Calculated for Action.

4. Click the Add icon next to Action to add a function with the following criteria:

Function math()

Tag Calculated Nominal Weight (lbs)

Operator /

Constant 2000

5. Add another function with the following criteria:

Function Tag()

Tag name Weight (ton)
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6. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1 . 4 CONCATENATE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to concatenate
model data. In the following examples you will see how you can concatenate model data using DTOs.

Data structured in models that you receive do not always provide data in a way that you can use. You
need to concatenate data to create unique tags.

MAKE UNIQUE TAG VALUES FOR MULTIPLE OBJECTS

1. Add a new DTO, and then name it Spool Number.

2. In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name Pipeline

Operator contains

Value RWS
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3. Use the and/or row toggle on the top left to select and.

4. Click on the Add row icon on the bottom left to create a new row, and then use the following
criteria:

Rule Type Tag

Tag / OP Name 00-CWA

Operator not null

5. In the Actions tab select Calculated for Action.

6. Click the Add icon next to Action to add a function, and then use the following criteria:

Function text()

Tag Name 00-CWA

7. Add additional rows, and then create a series of functions using dash as a constant as shown:

Function text()

Tag Name -

Function text()

Tag Name IN8_System - PowerPlant
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Function text()

Tag Name -

Function text()

Tag Name IN8_LineNumber - PowerPlant

Function text()

Tag Name -

Function text()

Tag Name -01

Function tag()

Tag Name IN8_SpoolNumber
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8. Click on the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

1 . 5 PARSE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to parse model data.
An example is if your project systems are concatenated into other metadata, you can parse it to its
own tag. In the following example you will see how you can parse model data using DTOs.

If your project systems are concatenated into other metadata, you should parse it to its own tag to
easily access the model by systems.
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PARSE SYSTEM INFORMATION

1. Add a DTO, and then name it Systems – Piping.

2. In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name Pipeline

Operator not null

3. Add a DTO, and then name it Systems – Piping.

4. In the Selector tab use the following criteria:

5. Use the and/or group toggle at the top right to select and.

6. Click the Add group icon at the top right, and then include the following group criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec AG Yard Piping.nwd

7. Click the Add row icon below the row to add another row, and then use the following criteria:

Rule Type Tag

Tag / OP Name Model

Operator =

Value Mec UG Yard Piping_rev1.nwd

8. Use the and/or row toggle above the grouped rows on the top left and select or.
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The selected criteria will find all objects with a Pipeline value. When you use the and group
toggle, it will select the objects from the listed model tag values.

9. Click the Test button to review and validate your selection criteria in the Selection Information
panel. Results should include AQ-00074001and CWR-00064101.

10. In the Actions tab select Calculated for Action.

11. Click the Add icon next to Action to add a new function, and then use the following criteria:

Function substr()

Tag Pipeline

Index of -

Offset 1

Length -3

The substr() function lets you parse out your selected characters within a string of
characters.

The Index of field can be blank, or you can enter any character from where you
want to start indexing. This example starts at the dash value in this string of
characters for AQ-00074001.
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12. Add another function with the following criteria:

Function tag()

Tag IN8_System

13. Click on the Run selected button to execute the DTO, and then create the new tag according to
your selection criteria.
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1 . 6 QUANT IFY MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to quantify model
data. In the following examples you will see how you can quantify model data using DTOs.

The InEight Model to InEight Estimate integration is the most efficient way to get quantities from a
model into an estimate. For more information, see Model-Estimate overview Overview.

The following examples do not use the InEight Estimate integration.
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1 .6 .1 EXTRACT QUANTIT IES FROM MODEL

You can sum up quantities from your model to use for estimating or tracking subs by installed
quantities.

l 1.6.1 .1 QUANTITIES BY COUNT

You can add a DTO to find specific model objects to sum up their quantities, and then utilize the
Quantity action type to sum the quantities by count.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Exclude children

Click on the Add row icon on the boottom left, and then use the following criteria:

Rule Type Tag

Tag / OP Name 80 - Construction Items

Operator =

Value Drilled Pier

Use the and/or row toggle on the top left to select and. When you use the and toggle, it means
that both rules must apply to model objectdata.
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In the Actions tab use the following criteria:

Action Quantity

Quantity Type count

Code FND PEIR

Units Items

Description Foundation Pier

You can give the Code and Description fields your own custom input to help
organize the data.

Click the Equals icon to see your quantities. You can also use the Operation and Value fields to
adjust your quantities, and then click the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

l 1.6.1 .2 QUANTITIES BY AREA

Add a DTO to find specific model object to sum up their quantities and then utilize the Quantity
action type to sum the quantities by area.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Use the and/or toggle at the top left to select and.

Click the Add icon on the bottom left, and then add the following criteria:

Rule Type Tag

Tag / OP Name 80 - Construction Items
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Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum area

Code FND PEIR

Units square feet

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value fields to
adjust your quantities, and then click on the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

l 1.6.1 .3 QUANTITIES BY VOLUME

You can add a DTO to find specific model object to sum up their quantities and then use the
Quantity action type to sum up the quantities by volume.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Use the and/or row toggle at the top left to select and.

Click the Add row icon on the bottom left, and then add the following criteria:

Rule Type Tag

Tag / OP Name 80 - Construction Levels
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Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum volume

Code FND PEIR

Units cubic yards

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value fields to
adjust your quantities, and then click the Equals icon to see your updated quantities.
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Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

l 1.6.1 .4 QUANTITIES BY TAG

You can add a DTO to find specific model object to sum up the quantities and then utilize the
Quantity action type to sum up the quantities using a tag.

Add a DTO, and then name it Foundation Pier.

In the Selector tab create the following rule criteria:

Rule Type Tag

Tag / OP Name 02 - Construction Levels

Operator =

Value G-Foundations

Exclude children

Use the and/or row toggle at the top left to select and.

Click the Add row icon on the bottom left, and then add the following criteria:

Rule Type Tag
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Tag / OP Name 80 - Construction Levels

Operator =

Value Drilled Pier

Exclude children

In the Actions tab use the following criteria:

Action Quantity

Quantity Type sum property

Tag IN8_Area (sf)

Code FND PEIR

Description Foundation Pier

Click the Equals icon to see your quantities. You can also use the Operation and Value fields to
adjust the quantities, and then click the Equals icon to see updated quantities.

Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.
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l 1.6.1 .5 ACCESS QUANTITIES VIA EXCEL PLUG-IN

Model has a plug-in for Microsoft Excel to access model quantities. To download the Excel Plug-
in Installer go to InEight Downloads.

After you install the plug-in, the InEight menu will show in the top menu ribbon of Excel.

Model and Excel interact with each other without the need to have the Excel application open.
However, the data created using quantity DTOs uses tables. You must be logged in to Model via
Excel to access the table data.

When you click on the InEight tab in Excel, you can log in using the same credentials you use for
Model.

Click Table-> admin-> config-> DTO-> DTO Estimate Record-> Query All.

The results of the Quantity DTOs executed in Model will show.
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1 . 7 VAL IDATE MODEL DATA

Data Transformation Operations (DTOs) provide flexible and repeatable processes to validate model
data. In the following examples you will see how you can find model objects that do not have certain
values or validate specific model data format. This information can be used to communicate any model
data that does not meet project requirements.

1 .7 .1 VAL IDATE MODEL DATA IS COMPLIANT

You can validate that specific model data meets your project requirements.

VALIDATE SPECIFIC MODEL DATA EXISTS

You can find model objects that do not have certain values, such as length.

1. Add a new DTO, and then name itW Shapes have no LENGTH

2. In the Selector tab use the following criteria:

Rule Type Tag

Tag / OP Name Revit_Family_Type
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Operator contains

Value W Shape

3. Use the and/or row toggle on the top left and change it to and.

4. Click the Add row icon under the row, and then use the following criteria:

Rule Type Tag

Tag / OP Name Length

Operator is null

5. Click the Actions tab, and then use the following criteria:

Action Tag

Tag Name 99 - Validation Issue

Tag Value No Length
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6. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

VALIDATE MODEL DATA FOR SPECIFIC FORMAT

You can validate that your Pipeline data has the system prefix followed by a dash, such as AQ-0001065.

First add a DTO to tag to all relevant data as invalid, and then create another DTO to find validated
data. The purpose is to place the invalid and valid tag values in the same tag name. When you use the
same tag name, the invalid data will switch to validated because an object can only have one value in a
tag name.

You must run both DTOs at the same time, and in the correct order in the list. First run invalid data,
and then validated data.

1. Add a new DTO group, and then name it Validation. Add a new DTO in the group for all Pipeline
data that will be tagged as invalid data, and then name it Pipeline – Invalid.
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2. In the Selector tab create the following criteria:

Rule Type Tag

Tag / OP Name Pipeline

Operator not null

3. In the Actions tab use the following criteria:
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Action Tag

Tag Name IN8_Validation - PowerPlant

Tag Value Pipeline - Invalid

4. Click the Run selected button to execute the DTO and create the new tag according to your
selection criteria.

5. Add another DTO in the group for all Pipeline data that will be tagged as valid data, and then
name the new DTO Pipeline – standard layout.

6. In the Selector tab create rule criteria to find all piping systems followed by a dash.

Rule Type Tag

Tag / OP Name Pipeline

Operator contains

Value List AQ- through WW-

Exclude none

7. Use the and/or row toggle on the top left to select or.

8. Click the Add row icon on the bottom left to add new rows, and then include all your values.
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9. In the Actions tab use the following criteria:

Action Tag

Tag Name Tag = IN8_Validation

Tag Value Pipeline - Validated
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10. Click on the Run selected button to execute the DTO and create the new tag according to your
selection criteria.
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2 . 1 STYL ING OVERV IEW

Materials and colors are not fixed, or assigned universally to all model objects, like they are in other
modeling environments. You have the flexibility to view the model in the way that makes sense for
yourself. In Model, you need to remember:

l Styles are the materials or colors in Model

l Style Sets are collections of assigned Styles

Styles allow you to switch between Style Sets to change the way you visualize the model. For example,
creating a Style Set that emphasizes a system, such as HVAC, or a Style Set that has the colors to
conform to an owner’s requirements. With these visually highlighted, it helps to identify those areas
which you want to focus on when looking at the model.

The Styling panel allows the manipulation of the appearance (surface and line, color and transparency)
of geometry. There are two tabs in the Style panel: Styles and Style Sets.

2 .1 .1 LAUNCH STYL ING MENU

To access the Styling panel, select View > Styling.
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l This will open the Styling window.

2 . 2 CREATE AND MANAGE STYLE SETS

There are predefined style sets grouped under Basic when a project is created. New style sets can be
created to represent real-world material characters such as glass and steel, or simple colors, to
represent different disciplines or systems.

The predefined style sets cannot be edited. They can be duplicated to create new,
custom style sets.
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2.2 STEP BY STEP 1 — CREATE A STYLE SET

1. Select Add.

l The New Style Set dialog box will open

2. Type in a desired name for your new style set (i.e. Major Systems).
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3. Click OK.
l The new style set will be grouped under the project name

4. Select the style set to make it active.
l Any styles applied will be a part of the active style set

2.2 STEP BY STEP 2 — EDIT A STYLE SET

Once one or more styles have been applied to a style set, the style set can be managed.
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1. Select a style set.
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2. Select Edit.
l The Edit Style Set dialog box will open

l To remove a style, click the red X.
l To reorder styles, drag a style up or down within the list.

When multiple style assignments apply to an object or tag, those higher in
the list take precedence.

3. When finished, select OK.
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2.2 STEP BY STEP 3 — DELETE A STYLE SET

1. Select a style set, then click the Delete icon.
l Or, right click on the style set, then select Delete Selected Style Set

2 . 3 CREATE AND ED IT STYLES

There are predefined styles, which cannot be modified, but can be duplicated to create a new style. All
newly created styles will be grouped under the project name.
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2.3 STEP BY STEP 1 — CREATE A NEW STYLE

1. Select the Styles tab and then select Add.

l The Edit Style window will open
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2. Click Choose Line Color... .
l Or toggle the Enabled box to have no outline color

l The Select Color dialog box will open

3. Select your desired color and click OK.
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4. Change the line thickness as desired.
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5. Click Choose Line Color.

l The Select Fill Color dialog box will open

6. Select you desired color and set an opacity if desired, then click OK.
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7. Select Save As… to save as a new style (i.e. Glass – Transparent).
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l The new styles will be grouped under the project name
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2.3 STEP BY STEP 2 — EDIT A STYLE

1. Select a Style Set, then click the Edit icon.
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2.3 STEP BY STEP 3 — SET A STYLE AS A DEFAULT

1. Select a style, then right click and select Make default for selected StyleSet.

Once Styles are assigned, then any style can be identified as the default (i.e.
Transparancy).
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2.3 STEP BY STEP 4 — DELETE A STYLE

1. Select a style, then click the Delete icon.
l Or, right click on the style set, then select Delete Selected Style

2 . 4 APPLY STYLES TO TAGS

Styles are appearance definitions. Assigning a style to a tag will change the appearance of model
objects with that tag. When a Style Set is active, it will be denoted at the top of the Styling panel.
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Styles can be applied to objects or tags; however, it is always preferable to use tags
whenever possible as this provides greater flexibility.

If a style was applied to an object and that object was removed and redrawn within the
design software, then that object will no longer be assigned the style.

2.4 STEP BY STEP 1 — APPLY A STYLE TO A TAG

1. Select a tag withing the Tags panel.
l This will select model objects

2. Withing the Styles tab, select a style, then click Assign.
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l Or, drag and drop a style on top of a tag

l This method will not select model objects

2 . 5 ASS IGN STYLES US ING EXCEL

Before beginning, ensure you have only one instance of InEight Model and one instance of Excel open.
Matching unique tag category and values need to be in the model and in Excel.

Within the Tags and Objects menu, identify a Category Name and its values. For this example, the Tag
Category will be Material and the Values are also shown as Glass, Metal and Stone.
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In Excel, type the tag and object names into the first cell on the Excel sheet.

Now that there is a unique tag category with values within excel that match the model, a style set can
be pushed from excel into the model.

2.5 STEP BY STEP 1 — COLOR EXCEL CELLS

1. Add color to the cells.

2. Within the Excel menu bar, select the InEight tab.
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3. Within the Visual Reporting section:
l Set ID Tag: click on a cell within the Tag Category, then select Set ID Tag.
l Set Color: click on a cell that has the color identified, then select Set Color.

4. In this case, the Set ID Tag and Set Color happen to be in the same column of Material. To
push these colors into the model and create a new style set, select Show in Model.
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l Your project in Model will reflect the colors selected for those objects. Once Show in
Model is executed, a new style set is created within the Styles Sets tab under Visual
Reports

This style will not be saved with the project in this state.

5. To save this style set with the project, right click on the style set and select Duplicate
Selected Style Set.
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l This new Style Set will appear under the project name

All model objects that were not affected by the defined color receive a
transparency.
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2 . 6 STYLE LEGEND

The Style legend option provides visibility into the color definitions applied to the geometry. You can
easily communicate the information to all project stakeholders.

You can open the Styling legend in View > Style Legend.

The Style Legend window opens and shows the style name, tag name, and tag value associations that
are included in the selected style set.
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The window automatically refreshes after you make a change to the active style set.

A selected Percent complete style set shows the percent complete for each element style color.

This provides the visibility of the status of each element, so you have the data to plan accordingly.
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LESSON 2 REVIEW

1. InEight Model offers basic, pre-defined styles.

a. True

b. False

2. When creating a new style, what two features can you set?

a. Line color, fill color

b. Fill color, shadow

c. Shadow, line color

d. None of the above

3. You can only apply a style at the project level.

a. True

b. False

LESSON 2 SUMMARY

As a result of this lesson, you can:

l Create and manage styles
l Create and manage style sets
l Apply styles to tags
l Assign styles using Excel
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3 . 1 MASTER PRESETS OVERV IEW

Create a master preset to capture and save the context or state of your project through a filtered lens
or camera angle. Navigate between master presets to help you effectively manage your model and
share your perspective with other users.

Master presets are created on a project level. Once created, anyone can use or edit your
master presets.

3 .1 .1 MASTER PRESET EDITOR

From an open model(s), navigate to the view that you want to save as a master preset. When ready to
capture that viewpoint, navigate to View and selectMaster Presets. Then, select Add and select your
preset preferences.

l Model Visibility shows models that are visible and in-view
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Once selected, Model Visibility will not show any new model streams that may be added
to the project. To set or adjust model visibility settings, open the Object panel or right
click menu to view the show/hide and selection options.

l Selected Objects shows any objects you have selected on the model

l Style Set shows any styles already assigned to the visible objects of your model

l Object Visibility saves the objects’ states so that any objects already hidden remain hidden

l Workspace saves the user interface configuration, their location, and current screen resolution

Selecting Workspace may cause undesirable results for users with different screen
resolutions and configurations. Avoid selecting the Workspace when working in a shared
preset.

When a custom Workspace is necessary, create and label a folder in your master preset
panel where you can save that preset. Add your Workspace selection (and parameters, if
possible) to the master preset description.

l Camera saves the current camera settings (i.e. the camera’s position in space, direction,
and depth of view)

l Archive saves any open documents in the Archive Library

Using Archive, you can bookmark pages within a document so that users open to a
specific page while viewing the project from your master preset.

l Sectioning shows any planes or sections of your model(s) that are visible

l Measurements shows selected measurements graphically or visually

l Camera Transition Time, with the Camera option selected, allows you to adjust the speed of the
camera’s transition time. The default Camera Transition Time is 1,000 milliseconds

If Camera is not selected, you cannot adjust the Camera Transition Time.

3 .1 .2 RESET WORKSPACE

If a master preset has messed up your workspace, you can reset your workspace by going to the
Settings and selecting Reset Workspace.
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3 .1 .3 R IGHT CLICK MENU FEATURES

Quickly access additional master preset options by right clicking within the Master Preset panel.

l Edit and Update Selected … opens the Master Preset Editor so you can quickly make and save
changes to a preset for the selected assets

l Update Select w/ Current Values updates a Master Preset with the current model view
configuration without opening the Master Preset Editor

l Set as Project Default will make the selected master preset the default view (of the project you
have open) anytime you load that project

l Copy URL to Clipboard copies the master preset of your project to share with other
collaborators

l Delete Selected deletes any selected master preset(s)

l Add Group … allows you to add a group from the right click menu

l Rename Group … allows you to rename a group from the right click menu

l Delete Group deletes any selected group(s)

l Expand All shows all folders in the master preset panel

l Collapse All collapses all folders in the master preset panel

l Export as Viewpoints allows you to create an XML file that you can import into Navisworks. In
other words, you can share your viewpoint (including any presets you have, the order of those
presets, and your spatial view of the model) with others through Navisworks
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3 . 2 CREATE AND MANAGE MASTER PRESETS

3.2 STEP BY STEP 1 — CREATING A MASTER PRESET

1. Select Add to create a new preset.

l The Master Preset Editor will open

2. Name your master preset.
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It is good practice to create one or more HOME master presets.

3. Next, check the filter selections you would like to apply to this preset.

Mouse over settings for tool tips.

4. Add a description to help others who use this preset to know what view of the project they
are seeing and why (optional).

5. When finished, select OK.

The description text does not wrap, so it is best practice to keep the description
short.

3 .2 .1 MASTER PRESET OBJECT VIS IB IL ITY MAXIMUM
DIALOG BOX

This is a rare notification that you could encounter when you are trying to Hide Unselected while you
are also selecting the Object Visibility option when creating the Master Preset.

You can also get that dialog box if you published one entire model from Navisworks.
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It is recommended that you publish discipline specific models or area specific models. Then select
objects, RMC, and select Hide Models from Unselected. Then RMC and select Hide Unselected. After
that, create the Master Preset with Object Visibility option.
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3.2 STEP BY STEP 2 — EDITING A MASTER PRESET

1. Select the master preset that you want to modify and select the Edit icon.

l The Master Preset editor will open
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2. Make your changes and select OK.

3.2 STEP BY STEP 3 — EDITING A MASTER PRESET - MODEL VIEW

1. Prepare your model view.

2. Select a master preset and click the Edit icon. Then, select OK.
l Or, right click on a master preset, then select Update Selected w/Current
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Settings

InEight Inc.  |  Release 24.9 Page 315 of 558

Model User Guide 3.2 Create and Manage Master Presets



3.2 STEP BY STEP 4 — DELETING A MASTER PRESET

1. Select the master preset that you want to remove and select the Delete icon.

3 . 3 ORGAN IZE MASTER PRESETS

Organize master presets into contextual groups to distinguish between executive-level, task-specific,
team-specific views. Drag and drop master presets and groups within the Master Preset panel to
create comprehensive organization.
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3.3 STEP BY STEP 1 — GROUPING MASTER PRESETS

1. Select the Group icon and enter a group name. Then select OK.
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2. Now, you can add presets to this group.
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Notice, you cannot drag and drop a group above the project name. That’s because
groups are created under the parent project.

3.3 STEP BY STEP 2 — SET A MASTER PRESET AS THE PROJECT
DEFAULT

A master preset can be set as the project default so that when a project loads the model view is set to
the default master preset.
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1. Right click on a master preset, then select Set as project default.

3 . 4 SHARE AND EXPORT MASTER PRESETS

Quickly communicate by sharing a master preset with other project collaborators. Add emphasis or
clarity by assigning colorful style sets and tags to your master preset. Or, use master presets to check
project progress or review changes by comparing the captured viewpoint against its archived state in
the Project History folder (View > Project History).
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3.4 STEP BY STEP 1 — SHARING A MASTER PRESET

1. Select and right click on the master preset that you want to share. Select Copy URL to
Clipboard.

l You can now paste your preset URL to an email, message, or other means of
communication.
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3.4 STEP BY STEP 2 — EXPORTING MASTER PRESETS

1. Right click on a master preset, then select Export as Viewpoints.
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LESSON 3 REVIEW

1. Master presets can help you to...

a. configure a custom workspace.

b. create profiles or filters of your model to convey specific information.

c. All of the above

d. None of the above

2. From the Master Preset Editor, selecting _____________ will show any planes of
your model that are visible.

a. Measurements

b. Sectioning

c. Archive

d. Model Visibility

3. Only project administrators can group or share presets.

a. True

b. False

LESSON 3 SUMMARY

l Create and edit master presets
l Group master presets
l Share master presets
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4 . 1 CLASH MANAGER OVERV IEW

Coordination is the process of using rules to identify hard and soft clashes, creating grouped clashes
into trackable issues, and assigning them to users or user groups to resolve.

Clash Manager rules are flexible rules established to detect clashes between model objects by
examining geometric relationships between tags. Clash manager rule groups can be created to
organize rules and to quickly execute multiple rules at the same time.

The Clash Manager results tab shows the clashes detected after running a rule.
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4 . 2 CREATE AND MANAGE COORDINAT ION
RULES

Coordination rules are triggers from tags. In Clash Manager, rules are created to fine-tune the
workload and the focus of the coordination.

A best practice is to create discipline focused rules. For example, when you clash piping/plumbing
versus steel, then make the piping/plumbing your primary tag and steel your secondary tag. This type
of rule groups related steel clashes to a single piping/plumbing clash.

4 .2 .1 CONSIDERATIONS

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.

Rules that are linked to issues are locked and cannot be modified.
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4 .2 .2 STEPS

To open the Clash manager, go to Logic > Clash Manager.

CREATE A COORDINATION RULE

1. In the Rules tab, click the Add icon. The Rule definition dialog box shows.

2. Enter a name in the Title field.

3. Select a Primary Tag Name and Primary Tag Value.

4. Select a Secondary Tag Name and Secondary Tag Value.

5. Add Tolerance Settings as needed. For more information, see Tolerance Settings.

6. Select the Include Objects From Same Model Stream checkbox if your primary and secondary
tags are within the same model stream.
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EDIT A COORDINATION RULE

1. Select a rule from the list.

2. Click the Edit icon. The Rule definition dialog box opens.

3. Make your rule definition changes in the Rule Definition dialog box.

4. Click the Save Rule Definition button.
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To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.

EXPORT RULES

1. Click the Export icon.

2. Select Export All Rules… or Export Selected Rules.... The export file is saved in a .cr file extension
in xml format.

IMPORT RULES

1. Click the Import icon.

2. Select the file to import, and then click the Import button.
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When importing, the tags identified in the rules are created as tags in the project if
they do not already exist.

4 . 3 TOLERANCE SETT INGS

Tolerance settings are used to define minimum clash tolerances or tolerance zone requirements
around objects. You can isolate an object, and then preview the selected object to visualize and
experiment with these settings.

The following table is a list of the available tolerance settings:

Setting Description

None Used to detect any geometric intersection.

Expand

Expands the geometry in all directions by the defined value.
l Use a negative number to require a minimum Clash Tolerance. Negative a
tenth of an inch will require a collision of a tenth of an inch or more before
listing it as a Clash.

l Use a positive number to establish a clearance zone around the object.
Positive one foot will list any geometry within a foot of the object as a Clash.

Sphere Establishes a spherical Clash Tolerance or Clearance Zone.

Cylinder Establishes a cylindrical Clash Tolerance or Clearance Zone.
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4 .3 .1 STEPS

You must first select an object. The object selected represents all objects with the same
Primary or Secondary Tag Value selected.

CREATE RULES FOR EXPAND, SPHERE, AND CYLINDER TOLERANCE
SETTINGS

1. Fill in the Rule definition fields to create a rule.

2. Select Expand for Tolerance Settings.

3. Select the Preview on Selected Object checkbox.

4. Select a Unit from the drop-down list.

5. Enter a value in the Value field.

Page 334 of 558 InEight Inc.  |  Release 24.9

4.3 Tolerance Settings Model User Guide



You can follow the same steps for Sphere and Cylinder tolerance settings as shown in the images
below:

Sphere
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Cylinder
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4 . 4 CREATE AND INTERROGATE CLASH
RESULTS

In Clash Manager you can run clash rules or rule groups to get clash results. The clash results can then
be reviewed and interrogated. To open Clash Manager, go to Logic > Clash Manager.

A best practice is to use a master preset to focus on a specific area of the federated
discipline models before running a rule to review focused clash results.

4 .4 .1 CONSIDERATIONS

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.
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4 .4 .2 STEPS

CREATE CLASH RESULTS

1. In the Clash Manager Rules tab, select a rule or rule group, and then click the Run rule icon.

The Results tab will open and show the clash results grouped by the primary tag selected in the
rule creation.
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2. In the Results tab, select a clash result, and then select a tag in the Select Tag Name drop-down
to view additional insight of the clash results.

3. To view a heatmap of results, click the Clash results settings icon to enable Issued Result and
Clash Points.
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4. Click the Select all clash results icon at the top left to group and view additional related clashes
to group into a single issue.

5. Click the Clear the results list icon to clear and deselect clash results.

To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.
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4 . 5 CREATE AND MANAGE COORDINAT ION
RULE GROUPS

Coordination rules can be run individually or as groups in the Clash Manager Rules panel. Coordination
rule groups let you run all rules that are relevant to a scope item at the same time. Rule grouping is
helpful when the project's overall scope is divided across the project team.

A best practice is to create discipline focused rules. For example, when you clash piping/plumbing
versus steel, then make the piping/plumbing your primary tag and steel your secondary tag. This type
of rule groups related steel clashes to a single piping/plumbing clash.

4 .5 .1 CONSIDERATIONS

Admin and Standard users can create coordination rules. Read-only users can also create coordination
rules but cannot save any actions to the project.

4 .5 .2 STEPS

To open Clash Manager, go to Logic > Clash Manager.
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CREATE A COORDINATION RULE GROUP

1. In the Rules tab, click the Add Group folder icon in the Groups section, and then enter the group
name.

2. Click the new group folder, and then click Add folder to create a sub-folder.

3. Select one or more rules, select a Group folder, and then click the Add to Group button.

To view the Rules and Results tab side-by-side, click the Expand icon at the bottom left of the panel.
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EXPORT RULES GROUPS

1. Click the Export icon.

2. Select Export All Groups... or Export Selected Groups.... The export file is saved in a .cr file
extension in xml format.
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4 . 6 SHOW DUPL ICATE OBJECTS

The Show Duplicate Objects option lets you perform duplicate checking operations in the aggregated
Model environment.

Based on the data reported using the show duplicate option, the design team can remove duplicate
object geometry from the authoring environment.

To see a list of duplicate objects, run the report in Logic > Show Duplicate Objects.

A new window opens that shows grouped duplicate objects and provides the source file information so
you can remove the duplicated geometry at the source.
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4.6.0 .1 EXPORT DUPLICATE OBJECTS

You can export and view the data in an Excel file. Click the Export icon at the bottom right to start the
export.

The default export file type is .csv.

The exported duplicate objects file can be imported to the archive library and attached to issues. You
can then export them to a BCF export for the engineering team to review.

InEight Inc.  |  Release 24.9 Page 345 of 558

Model User Guide 4.6 Show Duplicate Objects



LESSON 4 REVIEW

1. ___________ are created to detect clashes.

a. Styles

b. Tags

c. Coordination Rules

d. None of the above

2. Coordination rules can only be run individually.

a. True

b. False

3. ___________ define the parameters around objects for clash detection.

a. Clearance settings

b. Coordination issues

c. Coordination rules

d. None of the above

LESSON 4 SUMMARY

As a result of this lesson, you can:

l Create and manage a coordination rule
l Create and manage coordination rule groups
l Define clearance settings
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5 . 1 ISSUE MANAGER OVERV IEW

Issue Manager lets you turn geometric clash issues, model review, and site-walk findings into issues.
Issues can be grouped and then assigned and tracked all the way to completion.

The Issue Manager contains 3 tabs:

l Issues – View the list of issues grouped in folders.

l Details - Lets you add additional information such as status, assignee, set location pins,
resolution information, add additional views, attachments, and markups.

l Summary - Shows all clashes associated with the issue.

To view all tabs side-by-side, click the Expand icon at the bottom left of the panel.
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5 . 2 CREATE AND MANAGE COORDINAT ION
ISSUES

Coordination issues are groupings of geometric clashes, viewpoints, documents, and markups that can
be assigned to a user or a user group. You can create coordination issues without a geometric clash. All
issues created can be exported.

5 .2 .1 CONSIDERATIONS

When creating and managing issues, one best practice is to have the Clash Manager’s Results panel
and Issue Manager panel open side-by-side. After you run a clash rule or rule group, your focus will be
on their results in the Clash Manager’s Results tab and the Issue Manager.

5 .2 .2 STEPS

To open the Clash or Issue Manager, go to Logic > Clash Manager or Issue Manager.

ADD FOLDERS AND SUB-FOLDERS TO ORGANIZE ISSUES

1. In Issue Manager, to add a new folder, click the Add folder icon, and then name the folder.

2. To add sub-folders, select a folder, and then click Add folder icon.

CREATE A NON-GEOMETRIC CLASH ISSUE

1. Select a folder, and then click the Add issue icon. A new issue is created, and the Details panel
opens to fill in the issue details.

InEight Inc.  |  Release 24.9 Page 349 of 558

Model User Guide 5.2 Create and Manage Coordination Issues



CREATE A COORDINATION ISSUE FROM CLASH RESULTS

1. Open the Clash Manager and the Issue Manager’s panels side-by-side.

2. In Clash Manager, run a rule or rule group.

3. In Issue Manger, select or create a folder to push the clash results into.

4. Select a clash result, and then in the viewer, zoom into the result.

5. Right-click the clash result, and then select New Issue from selected result or Add selected
results to current Issue. The Details tab shows.

In the Details tab you can view and manage thumbnails, clashes, status, summary, views,
attachments, and markups. For more information about the Details panel, see Details panel
overview.
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To view the all tabs side-by-side in Issue Manager, click the Expand icon at the bottom left.

When you create an issue offline, the issue ID number shows as a GUID. An issue ID
number is assigned the next time you are online.

ADD MARKUP

1. In the Details panel, under Attachments and Markups, click the Add button. A New Markup tab
opens in the viewer window.

2. Markup the view using the markup tools.

You can edit the size of the text by highlighting the text and then using the
Thickness bar.

3. To save the markup, click Save to..., and then you can select Issue... or File....When saving to
Issue, it saves the markup to the issue. When saving to File, it saves the markup to a PDF file.

4. Click the Back to Model button to go back to the viewer.

5. To close the markup view, click the Close icon at the far right.

EDIT AN ISSUE

1. Select an issue, and then click the Edit issue icon. The issue opens in the Details panel.

You can view and edit thumbnails, pins, clashes, status, assignee, priority, due date, summary,
views, attachments, and markups.
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2. Select Clashes to view all clashes in the issue. You can edit active clashes and change to Ignore or
Resolved. When all the clashes are set to Ignored or Resolved, the issue status automatically
shows as Resolved.

When an issue is in Resolved status, the coordinator responsible should visually
inspect the issue to ensure it has been resolved in a satisfactory manner. The
coordinator can then change the issue status to Closed.

The status for a clash or clashes is automatically set to invalid when one or both intersecting
objects are deleted in the design application, the model is published to InEight Model, and the
Update Issue function is executed.

An invalid status indicates that InEight Model can no longer detect the clash since it cannot
detect the source object or objects. Invalid clashes are treated as resolved.

IMPORT ISSUES

1. In the Issues panel, select the Import icon.

2. Select your BCF file, and then select Open. Your files are imported to an Imported Issues folder.
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EXPORT ISSUES

1. In the Issues panel, select one or more issues or select a group folder that contains issues.

2. Click the Export icon, and then select BCF 2.1 or BCF 3.0.

3. You can then name and save the file. The file is saved in a .bcfzip file format which can be
opened in other applications as shown in the image below:
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UPDATE ISSUES

1. Publish a new model revision.

2. Click the Update Issues icon.

The resolved clashes automatically change the clashes in the issues to a Resolved status. If all
clashes are resolved, the status for the Issue also shows as Resolved.

DELETE A COORDINATION ISSUE

1. Select a coordination issue, and then click the Delete icon.

5 . 3 COORD INAT ION ISSUE REPORT ING

Coordination Issue Reporting can be achieved by accessing Issues through the Excel plugin.
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ACCESS ISSUES VIA EXCEL PLUGIN FOR REPORTING

1. In Excel, select InEight in the menu ribbon.

2. Click the Login icon to log into your project. The Login to InEight dialog box opens.

3. Enter your password.

l The Select Project dialog box opens.
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4. Select your project, then click OK.

l User, Acct, and Project are shown.

5. Select the Table icon.
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6. Hover over Tracked Issues > Tracked Issue, and then click Query All.

All the Coordination issues are shown. This is a direct view into the database
tables
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LESSON 5 REVIEW

1. Coordination issues are created from ______________ .

a. Model streams

b. Tags

c. Master presets

d. Clashes

2. Issue statuses always start as ______________ .

a. In progress

b. Open

c. Closed

d. Flagged

3. After resolving a coordination issue, the reviewer should physically review the site
to ensure the issue (and any potential related issues) is resolved.

a. True

b. False

LESSON 5 SUMMARY

As a result of this lesson, you can:

l Create clash results
l Create and manage coordination issues
l Find nearby clashes and add clashes to an existing issue
l Create and manage coordination results
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6 . 1 ARCH IVE OVERV IEW

The Archive is a repository for documents. Archive supports files of any size and type, provides fine-
grained permission controls, and retains a complete revision history. The Archive is accessible within
InEight Model, Mobile and Web applications.

Archive includes Archive Library for storing and managing files, and the Archive Viewer for viewing
supported files types.
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6 .1 .1 ARCHIVE L IBRARY

View, manage, and organize all project documents within the Archive Library. Create labels and link
documents to model object tags for enhanced usability.

To launch the Archive Library panel, select Archive > Library.

The Archive Library panel has two tabs: the Library tab and the Selection tab.

6.1.1 .1 LIBRARY TAB

The Library Tab contains all the documents imported into the project. It provides the means to
organize documents within a folder structure and to link documents to model object tags.

Documents associated to tags will maintain its association through model updates,
assuming no manipulation to tags.
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6 . 2 MANAGE DOCUMENTS

Documents can be grouped in a folder structure, have permissions set at the folder level, have labels
assigned, and access document information.

6.2 STEP BY STEP 1 — IMPORT DOCUMENTS

Documents in the Archive Library are either cached locally or only indexed from the online database.
Any document uploaded is automatically cached locally on the computer that uploaded it and is
represented by a green dot.

1. Select the Import icon.

2. Then select either File or Directory from the drop-down menu.
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• Windows Explorer opens

Drag and drop files and/or file folders into the Archive Library panel.

3. Browse to the File or Directory location.

4. If File was selected, select one or multiple documents to be imported, then click Open.

If Directory was selected, select on the directory folder to be imported, then click Open.
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• The Confirm Directory Import dialog box opens

5. Click OK.

6.2 STEP BY STEP 2 — DOWNLOAD DOCUMENTS

Any document within the Library represented with a red dot is only indexed from the online database
and needs to be downloaded to access it.

1. Within the Archive Library panel, select one or multiple documents.

2. Then select the Download icon.
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l Or right click and select Download Selected

l The Download dialog box opens

3. Click Download Selected.

l Download Entire Library: downloads and caches the entire library. Warning: this
can take a long time and use a lot of disk space with large libraries
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l Download Selected to External App: downloads the file directory to the local
computer without caching it locally to VEO_Cache

l Save to…: saves selected to a specific location

6.2 STEP BY STEP 3 — ORGANIZE DOCUMENTS

Organize and group documents by creating folders. Drag and drop folders and documents to rearrange
them as desired. Right click on the document or folder to rename it.

1. Within the Archive Library panel, click the Folder icon.

2. Name the folder.

6.2 STEP BY STEP 4 — DELETE DOCUMENTS OR FOLDERS

1. Select one or multiple document(s) or folder(s), then click the Delete icon.

2. Answer the validation response(s).
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Deleting a folder will delete all documents within the folder. The deleted
document/folder is not deleted from the local cache.

There are additional options for removing documents/folders within the Right Click menu under
Delete:

l Delete > From Archive Library: removes document/folder from library (same as
Delete icon)

l Delete > Selected from Cache: removes only the local cache copy of a document
l Delete > Historical Versions from Cache: removes previous versions of
document/folder from local cache

l Delete > Upload Data from Cache: removes all locally uploaded document/folders
from local cache Warning: this can take a long time and InEight Model will be
unresponsive while it is in progress
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6.2 STEP BY STEP 5 — ACCESSING DOCUMENT INFORMATION

Additional document information is maintained within the document information window within the
Archive Library panel.

1. Select a document.

2. With the mouse on top of the slider bar, click and slide open.
l Or right click on a document and select Show Document Information

l The Document Information window opens
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l History: displays the historical information of the document
l Labels: displays the list of available labels and which labels are associated to the
document

l Objects: displays objects linked to the document
l Tags: display tags linked to the document

Right click on a document and select Copy Selected File Information to Clipboard
to paste document information to an external application (i.e. MS Excel, Word,
Email, etc.).

6.2 STEP BY STEP 6 — APPLY PERMISSIONS TO FOLDERS

Only Admin users can apply specific folder permissions. By default, folder permissions are
inherited by project level permissions.
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Permissions can be set at the folder level. Nested folders inherit parent folder permissions. By default,
folder permissions inherit project permission for users.

1. Select a folder, then right click and select Edit Folder Permissions.
l The Set Archive permissions dialog box will open

There are three permission levels:

l None Granted: folder is hidden
l Can Read: read-only permissions
l Can Read and Write: has read, write, and edit permissions

2. Select a Read permission.
l Can Read permissions are auto assigned to all groups within the system and all
users assigned to the project
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3. Make any changes as desired, then click OK.

4. Select a Hide permission.
l None Granted permissions are auto assigned to all groups within the system and all
users assigned to the project

5. Make any changes as desired, then click OK.

6. Select View / Edit Current Permissions.
l Displays all Current Permissions for the folder with applying any changes as it opens
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6.2 STEP BY STEP 7 — SEARCH DOCUMENTS

Search filters the library list to the criteria in the search bar and only searches on the File Name of the
Document and/or Folder.

When using Filters in conjunction with Search, only visible content is searched.

1. Type in criteria within the Search bar.

6 . 3 CREATE AND MANAGE LABELS

Labels can be utilized to quickly group and filter files. Multiple labels can be assigned to files.

6.3 STEP BY STEP 1 — CREATE AND APPLY A LABEL TO A DOCUMENT

1. Select one or more documents.

2. Click the Label icon.
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l Or, right click and select Label Selected

l The Add or remove labels dialog box will open

3. Type in a name, then click Add.

Page 376 of 558 InEight Inc.  |  Release 24.9

6.3 Create and Manage Labels Model User Guide



InEight Inc.  |  Release 24.9 Page 377 of 558

Model User Guide 6.3 Create and Manage Labels



l The Label dialog box will stay open and show a checked box with a new label

Labels only display in the Add or Remove Label dialog box if they have been applied
to document. Once a label has been removed from all documents, it will no longer
appear in the Add or Remove Label dialog box.

1. Select anywhere outside of the Label dialog box to close it and apply the checked label.
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6.3 STEP BY STEP 2 — APPLY AN EXISTING LABEL TO A DOCUMENT

1. Select one or multiple documents.
l And/Or select one or more folders

2. Click the Label icon.
l Or right click and select Label Selected

InEight Inc.  |  Release 24.9 Page 379 of 558

Model User Guide 6.3 Create and Manage Labels



3. Select the desired labels to apply to the selected documents.

4. Select anywhere outside of the Label dialog box to close it and apply the checked label(s).
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6.3 STEP BY STEP 3 — APPLY OR REMOVE LABELS WITHIN THE
DOCUMENT INFO AREA

1. Select one or multiple documents.

2. With the mouse on top of the slider bar, click and slide the advanced panel open.
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l Manage labels within the Labels tab
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6.3 STEP BY STEP 4 — FILTER DOCUMENTS BY LABELS

1. Select the Filter icon.

l The Filter Criteria dialog box opens

The Filter Criteria is configured as an ALL criteria. The documents are filtered as ALL
criteria is met within the Filter Criteria dialog box.
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l Has Label: Filter documents according to checked labels
l Status: Filter documents according to their status (All, Unlinked Docs, Not
Downloaded, or Downloaded)

l Upload Date: Filter documents according Uploaded Date criteria
l UploadBy: Filter documents according to who uploaded the documents
l FileType: Filter documents by file type
l Clear: Clear

6 . 4 L INK AND MANAGE DOCS TO TAGS

Documents can be linked directly to model object tags. Linking documents provides a convenient way
to quickly access applicable documents by selecting model content within the 3D Viewer window.
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6.4 STEP BY STEP 1 — LINK DOCUMENTS TO TAGS

1. Within the Tags and Objects panel, select a Tag Value (i.e. Pile).

2. Within the Archive Library panel, select one or multiple documents.

3. Click the Assign icon.
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Drag and drop a document onto a Tag Value within the Tags and Objects panel.

6.4 STEP BY STEP 2 — ASSOCIATE A SPECIFIC PAGE WITHIN A PDF
DOCUMENT TO A TAG

After a PDF document has been linked to one or more model object tags, a specific page within the
PDF can be associated to the link, so that, when the document is opened via the link, it will open to the
associated page.

1. Select a PDF document that has been associated to a tag.

2. Open the Document Information window.
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3. Double click on the page number, then type in the desired page number.
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6.4 STEP BY STEP 3 — VIEW AND/OR REMOVE AN OBJECT TAG LINK
VIA THE DOCUMENT INFORMATION WINDOW

1. Select a document.

2. Open the Document Information window.

3. Select the Tags tab.

4. Select the Tag Link to view the linked model object.

5. Right click and select Remove Tag Link to remove the link.
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6.4 STEP BY STEP 4 — VIEW AND/OR REMOVE A DOCUMENT LINK VIA
THE SELECTION TAB

The Selection tab within the Archive Library displays all documents linked to the Actively Selected
Model Objects.

1. Select one or multiple model objects or a tag.

2. Within the Archive Library, select the Selection tab.

3. View associated document content by double clicking on the document.
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4. To remove a link, select a document from the list, then click on the Unassign icon.
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LESSON 6 REVIEW

1. You can view all project documents from the _____________ tab of the Archive
Library.

a. Objects

b. Tags

c. Selection

d. Library

2. You can only link a document to one object.

a. True

b. False

3. You can download documents from a model to keep on your desktop.

a. True

b. False

LESSON 6 SUMMARY

As a result of this lesson, you can:

l Import and manage documents
l Link documents to objects and tags
l Link specific pages
l View documents within InEight Model
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7 . 1 SELECT ION INFO OVERV IEW

The Selection Information panel displays attribute data of actively-selected model objects. The
displayed attribute data will change accordingly to the actively-selected model objects. The tabs within
the Selection Information panel displays grouped attribute data. If there are no model objects
selected, then the Selection Information panel will be blank.

7 .1 .1 SELECTION INFORMATION PANEL

To access the Selection Information panel, select Object from the menu bar at the top left of the
screen. Then, select Selection Information.
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7 .1 .2 GENERAL TAB

The General tab displays the Model Stream name of the selected objects, the Material Name – CAD
tag value for each model object selected, the total surface area, the total volume, and the total
number of objects currently selected.

7 .1 .3 TAGS TAB

The Tags tab displays all metadata for the selected objects, the number of objects per metadata, and
the total number of objects currently selected.
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There are additional actions that can be taken within the Tags tab: Filter the Selection,
Select similar tags, and Tag Selected objects with a new tag.

l Select Tag - Right Click on a tag value, then click Select Tag to select all objects with the
same tag
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l Tag Selected - Click the Tag Selected icon to open the Create Tag dialog box

7 .1 .4 STYLE TAB

The Style tab displays all the styles associated with the selected object.
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The Style tab will not display information when multiple objects are selected.

7 .1 .5 DOCUMENTS TAB

The Documents tab displays the documents associated to the selected objects.
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There are additional actions that can be taken within the Documents tab: Filter the
Selection, Open the Documents, or Reveal the documents in Archive Library.

Right Click on a document for additional actions.
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7 .1 .6 OBJECT PROPERTIES TAB

The Object Properties tab displays only the metadata that was selected as Object Property during the
Model Stream Export/Import process.
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There are additional actions that can be taken within the Object Property tab: Filter the
Selection and toggle a Parameter as a favorite. The favorited Parameters will appear at
the top of the list.

7 .1 .7 L INKED DATA

The Linked Data tab can be associated to Record Tables created within InEight Compliance.
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7.1.7 .1 SELECTION FILTER

The Selection Filter can be launch by clicking on the Filter icon from any of the tabs. Then uncheck any
of the Enable check boxes to fine tune your selection.
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LESSON 7 REVIEW

1. Which of the following is NOT a tab on the Selection Information panel?

a. Object Properties

b. Documents

c. Coordination

d. Linked Data

LESSON 7 SUMMARY

As a result of this lesson, you can:

l Navigate the Selection Information panel
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8 . 1 SECT ION ING OVERV IEW

Sectioning lets you isolate a certain section or area of a project to easily visualize model content.
Adjust the Sectioning box in the 3D viewer by managing the Top, Bottom, Left, Right, Front, and/or
Back planes of the box.

When the mouse cursor moves through the Sectioning panel a yellow outline is shown
along with a corresponding yellow line in the 3D view indicating the current edge of the
section.

8 .1 .1 SECTIONING PANEL

To access the Sectioning panel, select View from the menu bar at the top of the screen. Then, select
Sectioning.
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This opens the Sectioning Panel.

Toggle OFF to ON to initiate a section box. Toggle HIDE to SHOW to see the section box in the 3D View.

l Set Box – Sets the entire section box to the selected objects boundary. Or if no objects are
selected, then it resets the section box to the model boundary.

l Offset / Offset All – Adjusts the section box according to the entered criteria.
l TOP / BOTTOM / LEFT / RIGHT / FRONT / BACK – Can be enabled and can be set
according to selected objects or no objects selected. If objects are selected, then the
section is set to the object boundary. If no objects are selected, then the section is set to
the model boundary.

l Rotation – Rotates the section box.

8 .1 .2 SECTIONING ICON

Sectioning can also be switched ON or OFF with a left mouse click on the Section icon located at the
bottom left of the screen. Switch SHOW/HIDE, and launch the Sectioning Panel with a right click on
the icon.
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8 . 2 CREATE AND APPLY SECT ION ING

Sectioning can be applied in different ways to yield desirable results.

8.2 STEP BY STEP 1 — APPLY SECTIONING USING THE SET BOX

1. Switch Sectioning ON.

2. To see the sectioning box in the 3D viewer, toggle SHOW.

3. Select a model object or a tag.
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4. Click the Set Box icon.
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l The Sectioning box has been set to the model objects boundaries

8.2 STEP BY STEP 2 — APPLY SECTIONING BY DRAGGING AND
DROPPING A TAG

1. Switch Sectioning ON.

2. From the Tags and Objects Panel, select a tag.

3. Drag and drop the tag onto a section part in the Sectioning Panel.
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8.2 STEP BY STEP 3 — APPLY SECTIONING BY THE OFFSET

1. Switch Sectioning ON.

2. With the mouse over an Offset field, scroll the mouse wheel to set a numeric offset

3. Or type in the preferred numeric offset.
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8.2 STEP BY STEP 4 — MOVE SECTIONING PANES WITH GRIPS

1. Switch Sectioning ON.

2. Switch Section Box ON.

3. Hold the CTRL key and hover over the sectioning panes to see them highlight.

4. Hold CTRL + LMC (left mouse) to move a sectioning pane.
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8.2 STEP BY STEP 5 — RESET THE SECTIONING BOX TO MODEL
BOUNDARY

1. Switch Sectioning ON.

2. Ensure no model object is selected.

3. Click the Set Box icon.

Any of the Section Parts can be reset individually by ensuring that no model objects
are selected, then select the specific Section part Set icon (that is, Set Top).

8.2 STEP BY STEP 6 — USE SECTIONING WITH MASTER PRESETS

1. Switch Sectioning ON.

2. Adjust the Sectioning as desired.
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3. In the Master Preset Editor, click Sectioning.
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LESSON 8 REVIEW

1. You can quickly access sectioning from the Sectioning icon on the menu in the
bottom, left.

a. True

b. False

2. You can apply sectioning to master presets.

a. True

b. False

LESSON 8 SUMMARY

As a result of this lesson, you can:

l Apply sectioning using the set box
l Apply sectioning by dragging and dropping a tag
l Apply sectioning by the offset
l Reset the sectioning box to model boundary
l Use sectioning with master presets
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9 . 1 MEASUREMENTS OVERV IEW

The Measurements module lets you enter values to view your model in 3D, and then save the values in
a folder for reference and use later. You must select a measure Mode to take measurements.

9 .1 .1 MEASUREMENT WINDOW

To access the Measurements window, select View >Measurement. The Measurement window opens.

The Measurement window has six sections as shown below:
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1 Measurement settings – Measurement settings – Lets you manage the mode, units,
format, and precision of a measurement.

l Mode - Select between different modes to take your measurements:
o Point to Point - Basic Point A to Point B measurement.
o Continuous – Lets you continuously measure along a series of chosen points.
Double-click on the last point to end the continuous measurement.

o Area – Select a series of points that define an enclosed area. Close the area
measurement by clicking on Point A. Points picked must be on the same
plane.

o Angle – Lets you pick three points to find an angle.
o Spot ID – Select a point to show the X, Y, Z coordinates of the point. Spot IDs
can be copied to clipboard.

o Units - Select a unit to be shown when taking a measurement. Units are
constrained according to the type of mode that is selected and will be denoted
in italics and cannot be unselected.

o Format - Select a format to show when taking a measurement. Formats are
constrained according to the type of mode that is selected and will be denoted
in italics and cannot be unselected.

o Precision - Select the best precision for your measurement.

2 Measurement options – You can adjust how the measurement tools interact with objects
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and how measurements are calculated.
l Ignore Translucent – You can select or unselect the Ignore Translucent objects
during measurement mode. When selected, translucent objects in the view window
are ignored. This lets you indicate whether translucent objects, such as room,
operation, or maintenance volumes are included in the model project.
Measurements do not consider translucent objects.

l Respect Site Rotation - Measurement calculations are defined according to the
Site Rotation Values defined on Model stream import.

3 Object Snaps – Lets you select one or multiple object snaps to define selection type of
taking a measurement. Face and Object are exclusive snaps and cannot be active at the
same time.

l Vertex – Snap to any corner or endpoint.
l Midpoint – Snap to the middle of an edge.
l Center – Snap to the center of a face.
l Face – Snap to any face. The measurement is calculated according to the closest
point between the face selected and the other objects involved in the
measurement.

l Object – Snap to any object. The measurement is calculated according to the
closest point between the object selected and the other objects involved in the
measurement.

4 Selection Distance – The total value of the measurement is shown, along with the X, Y, Z
deltas when applicable.

5 Measurements – There are two root level groups in the Measurement tree. The Temp
group captures all measurements as they are created. The other group shows the Project
name, so you can create additional groups and organize project measurements.

6 Selection Details – All the details related to the selected measurement are shown. You
can copy and paste in the free-form text section.

9 . 2 APPLY AND MANAGE MEASUREMENTS

Enter the Measurement Mode to start measuring the model.
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9.2 STEP BY STEP 1 — ENTER MEASUREMENT MODE

1. Select the Ruler icon in the notification tray to toggle the Measure Mode on and off.

l Alternatively, press the M key on the keyboard to toggle the Measure Mode

While in Measure Mode the cursor will become a cross hair and the Ruler icon will
appear white.

Right-click on the Ruler icon to Start/Stop Measurement or to open the
Measurement panel.

9.2 STEP BY STEP 2 — TAKE A MEASUREMENT

1. Enter Measure Mode.

2. Select the first point (it will be labeled “A”).

3. Select the second point (it will be labeled “B”).

This lettering series will continue in order for measurement types consisting of
more than two points.
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l The first object in the measurement will be highlighted blue
l The second object in the measurement will be highlighted in red
l The total distance between the selected points will be displayed in orange along the
orange measurement line, which represents the closest distance between those
points

l Additionally, the X, Y, Z details of each axis will be drawn as dotted lines with their
respective values displayed along the path of the dotted line. The X, Y, Z axes will be
colored red, green, and blue respectively

While Measure Mode is active, hold control to restore navigation to move without
having to exit Measure Mode.
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l The first object in the measurement will be highlighted blue
l The second object in the measurement will be highlighted in red
l The total distance between the selected points will be displayed in orange along the
orange measurement line, which represents the closest distance between those
points

l Additionally, the X, Y, Z details of each axis will be drawn as dotted lines with their
respective values displayed along the path of the dotted line. The X, Y, Z axes will be
colored red, green, and blue respectively

While Measure Mode is active, hold control to restore navigation to move without
having to exit Measure Mode.
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9.2 STEP BY STEP 3 — DELETE A MEASUREMENT

1. Select a Measurement, then click the Delete icon.

Another option is to right-click on the measurement, then select Delete.

9.2 STEP BY STEP 4 — CLEAR MEASUREMENTS

Clear allows the user to clear any measurements selected, which also clears the 3D view of displaying
measurements.
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1. As one or more measurements selected, click the Clear icon.

9.2 STEP BY STEP 5 — ORGANIZE MEASUREMENTS

Create groups under the project named folder to move measurements into.

1. Select your project named folder.

2. Select the Group icon.
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Another option is to right-click on the folder, then select New Group.

l The New Folder dialog box will open

3. Enter a folder name, then click OK.

4. Drag and drop measurements into a folder.
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5. Right click on the measurement to rename it and better identify the measurement.
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LESSON 9 REVIEW

1. Which of the following is NOT an option on the Measurements panel? 

a. Master presets

b. Object Snaps

c. Selection Distance

d. Selection Details

2. You cannot save measurements in InEight Model.

a. True

b. False

3. To begin working with measurements, you must first enter Measurement Mode.

a. True

b. False

LESSON 9 SUMMARY

As a result of this lesson, you can:

l Navigate the Measurement panel and enter Measuring Mode
l Take and delete measurements
l Organize and clear measurements
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CHAPTER 10 — MODEL EXPORTS

10 . 1 I FC EXPORT

With IFC Export, you can select model objects and then export selected graphics and related TAG data
into an IFC file format. This provides the ability to export collaborative updates to project teams
members.

IFC 2x3 is the supported file type in Model. IFC files are an open international standard for Building
Information Modeling (BIM) data that are exchanged and shared among software applications used by
the various participants in the construction or facility management industry sector.

10.1 STEP BY STEP 1 — IFC EXPORT

1. To access IFC Export, select File from the menu bar at the top of the screen.

2. Select Export Selected to IFC…. The Windows Explorer opens.
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3. Browse to the desired location to store the .ifc file.

4. Name the .ifc file with a relevant name , and then click Save.

10 . 2 OBJ EXPORT

With the OBJ Export, you can select model objects, and then export selected graphics and related TAG
data into an OBJ file format.
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10.2 STEP BY STEP 1 — OBJ EXPORT

1. To access OBJ Export, select File from the menu bar at the top of the screen.

2. Select Export Selected to OBJ... Windows Explorer opens.

3. Browse to the desired location to store the .obj file.

4. Name the .obj file with a relevant name, and then click Save.
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TAKEOFF

11 . 1 MODEL -EST IMATE OVERV IEW

There are two methods for using Model quantities and integrating them with InEight Estimate, either
the Model and Estimate integration, or the quantity function in DTOs that integrate with the Microsoft
Excel Plug-in. For more information about DTO quantity integration with Excel Plug-in, see Access
quantities via Excel Plug-in in Quantify model data.

The following table shows Model integration for Estimate on-premise and SaaS.

Cost item information - Estimate to Model On-premise SaaS

CBS number ✓ ✓
Description ✓ ✓
Unit of Measure ✓ ✓
User defined field 11 x ✓
User defined field 12 ✓ ✓
User defined field 13 ✓ ✓
User defined field 14 ✓ ✓
User defined field 15 ✓ ✓



Cost item information - Estimate to Model On-premise SaaS

Parent level UDF 11 x ✓
Parent level UDF 12 x ✓
Parent level UDF 13 x ✓
Parent level UDF 14 x ✓
Parent level UDF 15 x ✓

11 . 2 MODEL AND EST IMATE INTEGRAT ION
US ING THE MODEL CONNECTOR

You can use Model to sum object quantities and sync them to Estimate using the Model Connector
functions. In Estimate, there are functions in the main ribbon of the CBS in the More Actions >Model
Connector section that integrate with Model.
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The Model Connector functions are described in the following table:

Function Description

Select in Model When you select a cost item, the linked Model
objects are selected in Model.

Frame selected When you select a cost item, the linked Model
objects are framed in the Model viewer.

Sync Model
Quantities

After you execute a DTO to sum quantities in
Model, you can then sync Model quantities into
Estimate.

Send Selected CBS
to Model

When you select a child item in the CBS structure,
then the parent hierarchy with that selected child
will be pushed to Model. When you push a parent
CBS item, then the parent and all children are
pushed to Model.
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When you send CBS cost items to Model, the CBS structure of the selected cost item or parent cost
item is sent to the DTO panel. On the DTO tab, the CBS hierarchy is converted into DTO Groups and
DTOs. All parent levels of the hierarchal tree create DTO Groups with the children level of the tree
creating DTOs .
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User-defined fields 11-15 are used to sync data to Model’s Selector and Action tabs in the DTO panel.
For more information, see User-Defined Fields. For more information about Model integration with
Estimate, see Model-Estimate overview.

11.2.0 .1 SUMMING QUANTITIES USING A PARENT COST ITEM

When a parent cost item is sent from Estimate to Model, the parent cost item becomes a DTO group in
Model. To estimate at a parent level, you must enter the Tag Name and Value information in User
Defined 12 and 13 fields in Estimate, and then send the parent cost item to Model.

In the DTO panel, the DTO tab shows the tree structure with the parent cost item as a DTO group and
as a DTO , and child cost items as DTOs.
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11 .2 .1 CONSIDERATIONS

• Estimate version 2023.0 or later must be installed.

• The Estimate add-in for Model Client Plug-ins must be installed.

• InEight Model must be installed.

• One instance of InEight Model and one instance of InEight Estimate must be open on the same
computer.

11 .2 .2 STEPS

SEND SELECTED CBS STRUCTURE TO MODEL’S DTO PANEL

1. Open one instance of Model and one instance of Estimate.

2. In Estimate, create or open a project, and then open the CBS register.

3. In Model, select Load a Project, and then open the DTO panel.
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4. In Estimate, select a cost item or a parent cost item.

5. In the top ribbon, selectMore Actions , and then select Send Selected CBS to Model in the
Model Connector section.

6. When the Estimate CBS items are sent successfully, a Success dialog box shows. Click OK in the
Success dialog box to close it.

RUN MODEL DTOS

1. In the DTO panel, select a DTO created from the CBS items sent from Estimate. You will see that
a rule is automatically created in the Selector tab based on the input from the user-defineld
fields in Estimate. For more information about creating rule types manually, see Manage DTOs.

2. Click Test to validate and review all the information for model objects in the Selection
Information Panel.

3. In the Actions tab, validate that the Quantity Type fields are set to the necessary summation of
the quantities.
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4. Repeat steps 1-3 for the other DTOs.

5. Run the individual DTOs or you can select higher in the hierarchy to run parent and child DTOs.
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SYNC MODEL QUANTITIES

1. After selecting to run DTOs, in Estimate, select Sync Model Quantities in the More Actions >
Model Connector section in the top ribbon. The Sync Model Quantities dialog box opens and, in
the Model, QTY column it shows the quantities in Model. The Current QTY column shows the
Forecast (T/O) Quantity in Estimate.

2. Select all cost items, and then click Accept. The quantities derived from the model are now in
Estimate.

SELECT AND FRAME MODEL OBJECTS

1. In Estimate > More Actions >Model Connector, select the check boxes for Select in Model and
Frame Selected.

2. Select a cost item in Estimate, and then in Model you can view which model objects were used
to create the quantities.
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11 . 3 USER-DEF INED F IELDS

When you use the Model Connector functions, user-defined fields (UDF)11-15 sync their data from
Estimate to the DTO panel in Model .

The following table shows the UDF integration to Model:

UDF Description

User Defined Actions tab - Populates the Tag Name in the Quantity Type sum property.
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UDF Description

11

User Defined
12

Selection tab - Populates the Tag / OP Name field in the first rule.

User Defined
13

Selection tab - Populates the Value field of UDF 12 Tag/OP Name in the first
rule.

User Defined
14

Selection tab - Populates the Tag / OP Name field in the second rule.

User Defined
15

Selection tab - Populates the Value field of UDF 14 Tag / OP Name in the
second rule.

UDF 11 does not integrate with Estimate on-premise.

DTOs use the Selector tab to create criteria for selecting model objects. The Actions tab creates the
summation of the quantities to share with Estimate.

When UDF 12 and UDF 13 are populated and UDF 14 and UDF 15 are not populated, then only one rule
is created in the DTO Selector area. If all four UDFs are populated, then two rules are created, and the
modifier is set to AND. The first rule is populated from UDF 12 and 13. The second rule is populated
from UDF 14 and 15.

The Tag / OP Name field must exist in the model or it will be blank. The Operator is set to
= by default. The Value must exist in the model, or it will be blank.

11 .3 .1 STEPS

The following are examples of UDFs integration with Model. We use cost item 2.1.1 for the examples.
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RULE SETUP USING USER DEFINED 12 AND 13 FIELDS

1. In Model, select a model object that represents the cost item. We will use cost item 2.1.1 - Pile
400mm Diameter to identify a tag name and value to use for UDF 12 and 13.

2. In Estimate, enter the following UDF information for cost item 2.1.1:

UDF Description

UDF 12 Estimating Tags

UDF 13 400mm Diameter

3. In More Actions >Model Connector, click Send Selected CBS to Model.

4. In the Success dialog box, click OK. A rule is created in Model > DTO > Selector tab from the data
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entered in the UDFs.
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RULE SETUP USING USER DEFINED 12-15 FIELDS

1. In Estimate, enter the following information for cost item 2.1.1:

UDF Description

UDF 12 Estimating Tags

UDF 13 400mm Diameter

UDF 14 Construction Zone

UDF 15 Area A

2. Click Send Selected CBS to Model, and then in the Success dialog box click OK. Rules are created

Page 448 of 558 InEight Inc.  |  Release 24.9

11.3 User-Defined Fields Model User Guide



in the Selector tab from the data entered in the UDFs.

RULE SETUP USING USER DEFINED 11 FIELD

1. In Estimate, enter Volume for cost item 2.1.1 in UDF 11.

2. Select Send Selected CBS to Model, and then in the Success dialog box click OK. The Quantity
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Type’s UoM is populated in the Action tab from the data entered in UDF 11.
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12 . 1 ELEMENTS OVERV IEW

Elements formalize relationships between components, equipment, systems, subsystems, etc.
Maintaining the thread of data from Design to Construction to Quality to Closeout; customizable based
on project requirements and participating in an Advanced Work Packaging process.

The new Elements panel within InEight model provides the capability to create Material Components
(individual or combined model objects). The Material Components created in Model are linked to the
AWP process (Model <-> Plan and Model <-> Schedule) and to the Completions applications.

Within Completions, Assets have been transitioned into Elements, which provides a direct link from
Completions to Model. In a general sense, Elements created in Completions are now visible within
Model and Elements created in Model are visible in Completions

Elements are more flexible than Assets in that they can have a hierarchical relationship and display
different data based on Element type or classification (system, subsystem, building intersection,
engineered equipment, etc.) With this transition, users can access Elements data from Completions
HQ, Mobile, and Model applications.

12 .1 .1 ELEMENTS PANEL

To access the Elements Panel, select View from the menu bar at the top of the screen. Then, select
Elements.
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This will open the Elements Panel.
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Elements created within the Model application or the Completions application will be displayed.

l Element Type: A dropdown selection to filter displayed Elements

l Add...: provides the ability to:

l Create a single Component

l Create multiple Components from a selection

l Settings...: provides the ability to:

l Toggle on/off the Auto-select model elements feature

l Toggle on/off the Show linked model elements feature

l Toggle on/off the Drop from Object Tree creates single Material Component feature

l Toggle on/off the Compact Mode feature

12 . 2 MANUALLY CREATED ELEMENTS

You can create elements and link tags or objects to those elements by clicking the Add icon or moving
tags and objects to the Elements panel.
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12.2 STEP BY STEP 1 — CREATE AN ELEMENT

1. Click the Addicon.

2. Select Add Component.

3. Fill in the component fields.
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Field name Value

1 Element Type Select Material Component.

2 Element Name Type in a name that represents the material component to be
created.

3 Description Enter a description for the material component.

4 Linked model
item

This is used only when Add Component from Selection option
is selected.

5 use Field
mapping

N/A

You can see the new completed component in the Create Element dialog box.
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4. Click OK, and then the new Material Component shows in the Elements panel.

The Element ID, Element Type, and Description cannot be changed. You must
delete and recreate a new element.

5. You can add a model object to the element two different ways:

l Drag one or more tags into the element from the Tags tab.
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The tags show below the element.

l Drag objects into the element by selecting one or more model objects from the
Objects tab.
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The objects show below the element.

The object values or tag values are linked to the element. When selecting
values in the Elements panel, those values are also selected in the Tags and
Objects tree.
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12.2 STEP BY STEP 2 — CREATE ELEMENTS FROM A SELECTION OF
OBJECTS

1. Select one or more model objects.

2. Click the Add icon.

3. Click Add Components from Selection.

The Create Element dialog box is populated.
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Field name Value

1 Element
Type

Select Material Component.

2 Element
Name

Do not delete <ObjName>. This ensures that all the added objects are
unique. You can add any text after the <ObjName> if needed.

3 Description Optionally type a description for the material component.

4 Linked
model items

This is used only when Add Component from Selection option is selected.

5 use Field
Mapping

N/A
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4. Click OK, and then the new Elements show in the Elements panel.

Each model object will have an element created with the individual model object
linked to that element.
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12.2 STEP BY STEP 3 — CREATE ELEMENTS FROM THE TAGS

1. To create elements from tags, in the Tags tab, drag one or more tags into the Elements panel.

The tags show below the element.

The element name will be derived from the tag, and the tag value is linked to the
respective element.

12.2 STEP BY STEP 4 — EDIT AN ELEMENT

1. In the Elements panel, right-click an element, and then select Edit Element.

The Edit Element panel opens and shows the associated element data.
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2. Edit the element as needed.

3. Click OK to save your changes. Fields that cannot be edited show in a solid color.

12.2 STEP BY STEP 5 — UNLINK OBJECTS FROM AN ELEMENT

1. Select an object or objects in one or more elements.

2. Right-click on the selected items, and then select Unlink item.
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12.2 STEP BY STEP 6 — DELETE AN ELEMENT

1. Select one or more elements.

2. Right-click on the selected items, and then select Add/Remove Element > Delete Selected
Elements.
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12 . 3 AUTOMAT ION OF ELEMENT CREAT ION -
ACT IV ITY COMPONENTS

You can automate element creation using DTOs and automatically sync with InEight Plan. When you
create elements using DTOs, the DTOs automatically link model objects to elements and creates
activity components in Plan.

12 .3 .1 STEPS

CREATE ELEMENTS AND ACTIVITY COMPONENTS USING DTOS

1. On the DTO tab, add a DTO.

2. On the Selector tab, find the model objects to create elements and activity components.

3. In the Actions tab, select Element for Action, and then use the following criteria:

Mode Create

Element Component
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Type

Component
Type

Activity

Tag
Category

Select a tag that uses values to create elements in Model and activity
components in Plan.

4. Click Configure, and then add rule types to select metadata to create activity components in
Plan.

5. Click the Add row icon to add a new Rule Type, and then use the following criteria:

The tables below are recommended rule types that provide the minimum
information. Tables within the Table Name drop-down fields show data that aligns
with Plan, Control, and Platform data. In the Table Name, select Component Core
Data to use the minimum required data to create an activity component.

12.3.1 .1 USING CLAIMINGSCHEME ID FOR FIELD NAME

Table
Name

Component Core Data

Field
Name

ClaimingScheme Id

Rule Type Constant

Constant
Value

This field integrates with Plan. Select the applicable claiming scheme for
the model objects selected.

Operator =

12.3.1 .2 USING DESCRIPTION FOR FIELD NAME

Table Name Component Core Data

Field Name Description

Rule Type Tag
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Tag Name Select an applicable tag name for the model object description.

Operator =

12.3.1 .3 USING DISCIPLINE ID FOR FIELD NAME

Table Name Component Core Data

Field Name Discipline Id

Rule Type Constant

Constant
Value

This field integrates with Plan. Select the applicable discipline for the
model objects selected.

Operator =

12.3.1 .4 USING QUANTITY FOR FIELD NAME

Table Name Component Core Data

Field Name Quantity

Rule Type Tag

Tag Name Select an applicable tag name to sum quantities

Operator SUM

12.3.1 .5 USING UOM FOR FIELD NAME

Table Name Component Core Data

Field Name UoM Id

Rule Type Constant

Constant
Value

This field integrates with Platform. Select the applicable UoM that aligns
with the WBS.

Operator =
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12.3.1 .6 USING WBS ID FOR FIELD NAME

Table Name Component Core Data

Field Name WBS Id

Rule Type Constant

Constant
Value

This field integrates with Control. Select the applicable WBS for the
model objects selected.

Operator =

6. Click OK to save your configuration.

7. On the DTO tab, click Save.

8. Select File > Save Project to save your project changes.

9. On the DTO tab, click Run selected to create elements with the configured information and
automatically link the model objects to the elements. The image below is an example of new
element with the configured data:
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10. Click File > Save Project to create activity components in Plan. A notification is sent to Model
from Plan notifying you whether the components are created or rejected.

12 .3 .2 CONSIDERATIONS

l The Model environment must be integrated with InEight Platform.

l Customer has purchased Model and Plan.

12 . 4 AUTOMAT ION OF ELEMENT CREAT ION -
MATER IAL COMPONENTS

You can automate element creation using DTOs and automatically sync with InEight Plan. When you
create elements using DTOs, the DTOs automatically link model objects to elements and creates
material components in Plan.
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12 .4 .1 STEPS

CREATE ELEMENTS AND MATERIAL COMPONENTS USING DTOS

1. On the DTO tab, add a DTO.

2. On the Selector tab, find the model objects to create elements and material components.

3. On the Actions tab, selectMaterial for Action, and then use the following criteria:

Mode Create

Element
Type

Component

Component
Type

Material

Tag
Category

Select a tag that uses values to create elements in Model and material
components in Plan.

4. Click Configure, and then add rule types to select metadata to create material components in
Plan.
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5. Click the Add row icon to add a new Rule Type, and then use the following criteria:

The table and image below show an example of a rule type. Tables in the Table
Name drop-down field show data that aligns with Plan data. There is no minimum
required data to create material components.

Table
Name

Component Core Data

Field
Name

Description

Rule Type Tag

Tag
Name

This field integrates with Plan. Select the applicable description for the
model objects selected.

Operator =

6. Click OK to save your configuration.

7. On the DTO tab, click Save.

8. Select File > Save Project to save your project changes.

9. On the DTO tab, click Run selected to create elements with the configured information and
automatically link the model objects to the elements. The image below is an example of new
element with the configured data:
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10. Click File > Save Project to create activity components in Plan. A notification is sent to Model
from Plan notifying you whether the components are created or rejected.

12 .4 .2 CONSIDERATIONS

l The Model environment must be integrated with InEight Platform.

l Customer has purchased Model and Plan.

12 . 5 AUTOMAT ION OF ELEMENT CREAT ION -
AGGREGATE COMPONENTS

You can automate element creation using DTOs and automatically sync with InEight Plan. When you
create elements using DTOs, the DTOs automatically link model objects to elements and creates
assemblies in Plan.
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Aggregate components in Model integrate with assembly components in Plan.

12 .5 .1 STEPS

CREATE ELEMENTS AND AGGREGATE COMPONENTS USING DTOS

1. On the DTO tab, add a DTO.

2. On the Selector tab, find the model objects to create elements and aggregate components.

3. On the Actions tab, select Element for Action, and then use the following criteria:

Mode Create

Element
Type

Component

Component
Type

Aggregate

Tag
Category

Select a tag that uses values to create elements in Model and assembly
components in Plan.
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4. Click Configure, and then add rule types to select metadata to create assembly components in
Plan.

5. Click the Add row icon to add a new Rule Type, and then use the following criteria:

The table and image below show an example of a rule type. Table names within the
Table Name drop-down field show data that aligns with Plan data. There is no
minimum required data to create material components.

Table
Name

Component Core Data

Field
Name

Description

Rule Type Tag

Tag
Name

This field integrates with Plan. Select the applicable description for the
model objects selected.

Operator =

6. Click OK to save your configuration.

7. On the DTO tab, click Save.

8. Select File > Save Project to save your project changes.

9. On the DTO tab, click Run selected to create elements with the configured information and
automatically link the model objects to the elements. The image below is an example of new
element with the configured data:
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10. Click File > Save Project to create activity components in Plan. A notification is sent to Model
from Plan notifying you whether the components are created or rejected.

12 .5 .2 CONSIDERATIONS

l The Model environment must be integrated with InEight Platform.

l Customer has purchased Model and Plan.

12 . 6 QUANT ITY CLA IM ING

You can perform component claiming and sync changes with InEight Plan. You can mark the
completion of claiming schemes in full or enter a partial install quantity.

The following image shows claiming in the Elements panel:
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12 .6 .1 STEPS

l Is Complete – Mark the item’s checkbox to do a complete claiming.

l Install Quantity – Click in the Install Quantity field, and then enter the partial quantity you want
to claim.

l Save Changes – Click File > Save Project to save your changes and sync with Plan. When you
select Save Project, a Save Changes dialog box shows with the pending updates. Click Save to
sync the changes with Plan.

l Project updates – When the sync to Plan is complete, a You have project updates banner shows
at the bottom left of the panel. The Project updates icon’s color at the bottom of the panel also
turns to green. You must click the Project updates icon, and then select Update Now to update
Model.

InEight Inc.  |  Release 24.9 Page 477 of 558

Model User Guide 12.6 Quantity claiming



12 .6 .2 CONSIDERATIONS

Reverse claiming must be done in the Plan application. After you reverse claiming quantities in Plan,
changes will sync in Model.
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LESSON 12 REVIEW

1. The Material created are linked to the AWP process.

a. True

b. False

2. Elements have more ______________ than Assets in that they have a __________
___________ relationship and display different data based on Element type.

a. information, variety

b. flexible, hierarchical

c. relationship, classification

3. Elements formalize relationships between these: (select all that apply)

a. tags

b. components

c. equipment

d. assets

e. data

f. systems

g. subsystems

LESSON 12 SUMMARY

As a result of this lesson, you can:

l Navigate the Elements panels and dialogs

l Know how to create an Element

l Create Elements from objects

l Unlink objects from an Element

l Delete an Element
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CHAPTER 13 — ADVANCED WORK
PACKAGING & WORKFACE
PLANN ING

13 . 1 WORK PACKAG ING OVERV IEW

InEight Model allows visual work packaging to support an Advanced Work Packaging (AWP), Work Face
Planning (WFP), or any other work scoping process.

Work Packaging breaks down projects into small, manageable scopes of work so that operation can be
assigned to responsible supervision, executed, and tracked effectively. Within InEight, our approach is
to break the work of your project into Construction Work Areas (CWAs), Construction Work Packages
(CWPs), and Installation Work Packages (IWPs).

AWP activities span the entire project. Front-end planning and detailed engineering activities support
enhanced execution at the work front. Project set-up and planning sessions establish the basis for
coordinated construction, procurement, and engineering work packages (CWPs, PWPs, and EWPs).

AWP drives the WFP concepts to Engineering and Procurement. Drawings are issued to construction
and vendors as complete Engineering Work Packages (EWP) and Procurement Work Packages (PWP)
instead of individual drawing releases. The objective is to ensure all parties follow the project Path of
Construction.



13 .1 .1 AWP PANEL

To access the AWP Panel, select View from the menu bar at the top of the screen. Then, go to the
Optional Modules and then select AWP.
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This opens the AWP Panel.

• AWP Panel will display Work Packaging structure items (CWA, CWP, IWP) created in InEight Model,
InEight Plan, or InEight Schedule applications

• Name: Work Package unique name or code

• Description: Brief work package description

• Start: Schedule start date

• Finish: Schedule finish date

• % Complete: Percent complete (earned work-hour basis)

• Platform: Identifies which platform (Model, Plan, Schedule) created work package structure item

• Add: provides the ability to:

l Add CWA

l Add CWP
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l Add IWP

l Remove Item

• Settings: provides the ability to:

l Toggle on/off the Auto-select material components feature

l Visually select model objects that are assigned to work package structure

l Toggle on/off the Show % complete feature

l Activates progress visualization mode

l Toggle on/off the Compact Mode feature

l Reduces AWP panel down to only show CWA/CWP/IWP names

l Toggle on/off the Edit RUID feature

l Opens the AWP panel column customization widget

13 . 2 CREAT ING & MANAGING CWA, CWP &
IWP

The InEight platform allows users to generate AWP structure components (Construction Work Areas
(CWAs), Construction Work Packages (CWPs), and Installation Work Packages (IWPs)) within Schedule,
Plan, and Model. InEight’s cloud-based platform allows real-time synchronization between the
solutions.

Adding to the existing AWP structure or creating a new structure to reflect the current project status is
available in the Model.
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13.2 STEP BY STEP 1 — CREATE A CONSTRUCTION WORK AREA
(CWA)

1. Select Add.

2. Click Add CWA.
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3. Fill out the CWA ID (project unique code or identifier).

4. Click OK, then the new CWA will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the CWA.
Any CWA created in InEight Plan or Schedule will be available within Model.
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13.2 STEP BY STEP 2 — CREATE A CONSTRUCTION WORK PACKAGE
(CWP)

1. Select an existing CWP item, then Select Add.

2. Click Add AWP.
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3. Fill out the CWP ID (project unique code or identifier).

4. Click OK, then the new CWP will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the CWP.
Any CWP created in InEight Plan or Schedule will be available within Model. With
the InEight platform, additional metadata associated with the CWP will be visible
within the InEight Model. Connecting AWP structure with InEight Schedule allows
for schedule metadata to be visible within the InEight Model. Connecting AWP with
InEight Plan & Progress allows for work-hours, progress percent complete, and
other metadata to be visible within the InEight Model.
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13.2 STEP BY STEP 3 — CREATE A INSTALLATOIN WORK PACKAGE
(IWP)

1. Select an existing CWP item, then Select Add.

2. Click Add IWP.

3. Fill out the IWP ID (project unique code or identifier).
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4. Click OK, then the new IWP will display within the AWP panel.
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The platform name highlights which of the InEight solutions generated the IWP.
Any IWP created in InEight Plan or Schedule will be available within Model. With
the InEight platform, additional metadata associated with the CWP will be visible
within the InEight Model. Connecting AWP structure with InEight Schedule allows
for schedule metadata to be visible within the InEight Model. Connecting AWP with
InEight Plan & Progress allows for work-hours, progress percent complete, and
other metadata to be visible within the InEight Model.

13.2 STEP BY STEP 4 — DELETING AWP STRUCTURE

1. Select one or multiple AWP structure items.

Removing AWP structure items (CWA / CWP / IWP) must happen at the lowest
level of the structure first. If an IWP has elements associated with it, these
elements must be unlinked before deleting. The same logic applies to CWPs and
CWAs.

2. Right mouse click on the AWP structure items, then select Remove IWP (or Remove CWP, or
Remove CWA).
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13.2 STEP BY STEP 5 — FILTER AWP STRUCTURE

Filter the AWP structure per predefined criteria

Select one or multiple AWP structure items.

1. Select the Filter tab, then set the criteria as desired.

Additional filters can be added as desired.

13 . 3 QUANT ITY CLA IM ING

You can perform component claiming at the Construction Work Package (CWP) level and the
Installation Work Package (IWP level and sync changes with InEight Plan. You can mark claiming in full
or enter a partial install quantity.

When selecting an IWP for claiming, you can claim for each step in the Claiming tab. The steps are
listed across the claiming tab from left to right.

The following image shows claiming in the AWP panel:
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13 .3 .1 STEPS

l Is Complete – Mark the item’s checkbox to do a complete claiming.

l Install Quantity – Click in the Install Quantity field, and then enter the partial quantity you want
to claim.

l Save Changes – Click File > Save Project to save your changes and sync with Plan. When you
select Save Project, a Save Changes dialog box shows with the pending updates. Click Save to
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sync the changes with Plan.

l Project updates – When the sync to Plan is complete, a You have project updates banner shows
at the bottom left of the panel. The Project updates icon’s color at the bottom of the panel also
turns to green. You must click the Project updates icon, and then select Update Now to update
Model.

13 .3 .2 CONSIDERATIONS

Reverse claiming must be done in the Plan application. After you reverse claiming quantities in Plan,
changes will sync in Model.

CHAPTER 13 — SCHEDULE

13 . 1 INE IGHT V ISUAL REPORT

The InEight Visual Report tab shows all the visual reporting data from the existing InEight tab and
includes additional functions that you can use to build visual reporting data.

After you set the ID tag, you can use the following tools to customize the inspector:

l Add schedule start and finish dates.
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l Use Settings to open the Interrogator Settings to set scheduled functions that includes define
colors, enable Show Complete, change date settings, configure auto increment settings.

l Configure the increments in days, weeks, or months to view date ranges and track scheduled
items.
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l You can view your IWP selection in Model by clicking the Show in Model button.

l When On Auto Increment is selected in settings, and you click the Auto Increment button, a
style set is created for every increment amount selected. You can select each style set scheduled
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increment and view in the model.
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CHAPTER 14 — USER
MANAGEMENT

14 . 1 USER MANAGEMENT

When InEight Model is integrated with InEight Platform, users are managed in Platform. For more
information, see User management in Suite administration.
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15.1 Introduction 501
15.2 Login 501
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15.5 User Access Overview 509
15.6 User Account Management 510

15 . 1 INTRODUCT ION

Admin Tools are not integrated with InEight Platform, therefore it is a central portal for administrators
to configure the settings of Legacy Completions, Model projects, and user accounts.

15 .1 .1 BROWSER COMPATIB IL ITY

Admin Tools is compatible with the following browsers:

l Chrome

l Firefox

l Safari

l Edge

15 . 2 LOG IN

Single sign-on (SSO) reduces the need to maintain separate credentials to access Admin Tools. You can
use existing credentials to open Admin Tools.



Conversion to single sign-on (SSO) applies across all InEight Model and Completions
applications including Admin Tools and the Excel Plugin.

You must go through your InEight services representative to convert to SSO.

One SSO user per email address is permitted in an account.

The login screen lets you use a single set of credentials and authenticate with SSO provider (Google or
Microsoft) to sign into any projects that you have access to. SSO increases administrative efficiency by
mitigating new user creation. Existing users can continue to sign in using their existing user name and
password.

SSO authentication reduces the need to maintain separate credentials, and also minimizes the need to
maintain a standalone set of credentials.

To enable SSO functionality for your organization, contact your account administrator.

User organizations can integrate with the Excel Plugin authentication service with their own existing
authentication servers, which eliminates the need for standalone Excel Plugin user credentials.
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Single sign-on recognizes which accounts users have access to, and presents a helpful account drop-
down list. Authenticated users are then presented with a list of projects in the selected account that
are controlled and assigned by the administrator.

15 .2 .1 LOG- IN OPTIONS

15.2.1 .1 USERNAME AND PASSWORD CREDENTIALS

RESET PASSWORD

If you forget your password, click Forgot password. Enter your user name, account, and email address,
and then click Submit. If your request is successful, an email is sent to you with instructions to
complete your password reset. Return to the login page to enter your new password.

The Submit button is disabled until you enter a valid email address..
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15.2.1 .2 SSO BY MICROSOFT
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15.2.1 .3 SSO BY GOOGLE

15 .2 .2 SWITCH ACCOUNT

The Switch account button, located on the lower left panel, lets SSO users change between accounts to
access different project lists.
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15 . 3 SL IDE -OUT PANEL

The slide-out panel gives you quick links to pages both inside and outside of Admin Tools. You can also
use the slide-out panel to log out of Admin Tools.
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To open the slide-out panel, click theMain menu icon.

The slide-out panel contains the following links:

l User Account Management – See User Account Management for information about this page.

l Online Training Portal – Takes you to the Knowledge Library.

l Completions Web – Opens the Completions web interface in your browser.

l Feature Request – Submit a request for a new feature.

l Support – Opens an email to InEight support.

l Switch Account - Lets SSO users change between accounts to access different project lists.

15 . 4 PROJECTS

The Projects page shows all available projects. When you log to Admin Tools, the Projects page is the
first page that opens. You can also click the Home icon to open the Projects page.

There are several methods to open the Configurations page opens for a specific project:
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l Double-click the project name.

l Select a project, and then click Configure.

l Right-click a project, and then select Configure from the drop-down menu.
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15 . 5 USER ACCESS OVERV IEW

There are three types of users:

User type Description

Admin Allows you to have complete access and control of all
functionality in the environment.

Standard Allows you to have limited access and functionality in a
project. You will not be able to:

l Create users.
l Create projects.
l Delete an object in Viewer.

Read-Only Allows you to have read-only rights to a project. You can
access and utilize all functionality in a project. You will not
be able to:

l Save any changes to a project.
l Create users.
l Create a project.
l Publish models.

The default user type is Standard. You can assign a user type when creating a new user.
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Users can have Read or Write access to a project.

If a Read Only type user is applied to a project with Write access, they will still only have
read only rights to the project.

If a Standard or Admin type user is applied to a project with Read Only access, they will
only have read only access.

15 . 6 USER ACCOUNT MANAGEMENT

User Account Management settings let you manage users, user groups, and access to projects. You can
navigate to User Account Management through the quick link in the slide-out panel.

You must be an account administrator to manage user accounts.

The User Account Management has two tabs:
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l Users & Groups – Manage users and user groups.

l Project Permissions - Assign users and user groups to projects.

15 .6 .1 USERS & GROUPS TAB

The Users & Groups tab has two panels. The Users panel lets you manage users, and the Groups panel
lets you manage groups. You can use the buttons in the center of the page to add and remove selected
users to and from groups.

15.6.1 .1 USERS

You can select the following user types:

User type Description

Admin Create and manage users and duplicate projects.

Standard Limited access and functionality in a project.

Read-Only Unable to make changes to a project even if you have other roles that would
otherwise allow it.
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See User Access Overview for additional information.

15.6.1 .2 CREATE SINGLE SIGN-ON OR PASSWORD USER

When creating a new user, the SSO On toggle lets you choose between creating a single sign-on (SSO)
user, or a user that logs in using their user name and password. The default setting is On. This cannot
be changed in edit mode.
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ADD USER

15.6 STEP BY STEP 1 — ADD USER

1. Click the Add user icon in the Users panel.

The Create User dialog box opens.

2. Fill in the required fields indicated by an asterisk, and then click Save.

The SSO toggle lets you choose between creating an SSO user, or as a user that signs in with a user
name and password. To add a user that signs in with a user name and password, switch the SSO On
toggle to Off.
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EDIT USER

15.6 STEP BY STEP 2 — EDIT USER

1. Select a user from the Users panel.

2. Click the Edit user icon at the top of the Users panel.

You can also right-click a user, and then select Edit User in the drop-down menu.

3. Make the updates in the dialog box, and then click Save.

The user name cannot be edited, and the SSO toggle cannot be changed in edit mode.

ACTIVATE USER

To activate a user, right-click the user, and then select Activate User in the drop-down menu.

To see a list of deactivated users that you want to activate, enable the Show deactivated
Users toggle at the bottom of the Users and Groups panel.

DEACTIVATE USER

To deactivate a user, right-click the user, and then select Deactivate User in the drop-down menu. A
deactivated user can no longer access their account.

RESET A USER'S PASSWORD (SSO OFF)

To reset a user's password, right-click the user, and then select Reset Password in the drop-down
menu. The user receives an email with instructions and a link to reset their password.

SET A USER'S TEMPORARY PASSWORD (SSO OFF)

To set a temporary password for a user, right-click the user, and then select Set Temp Password in the
drop-down menu. A temporary password lets you manually set a new password for the user.

DELETE A PENDING USER

To delete a pending user right-click the user, and then select Delete User in the drop-down menu.

You can only delete pending users for non-SSO users.
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RESEND ACTIVATION EMAIL (SSO OFF)

To resend an activation email to a pending user, right-click the user, and then select Resend Account
Activation Email in the drop-down menu.

15.6.1 .3 GROUPS

Groups are made up of multiple users. You can assign multiple users to projects using groups.

ADD A GROUP

To add a new group, click the Add group icon at the top of the Groups panel. In the dialog box enter a
group name, and then click Save.

DELETE A GROUP

To delete a group by right clicking a group, and then selecting Delete Group in the drop-down menu.

A group must unassigned to be deleted.

RENAME A GROUP

To change a group's name, right click a group, and then select Rename Group in the drop-down menu.

The new group name is shown in all historical data about the group.

15 .6 .2 PROJECT PERMISSIONS TAB

The Project Permissions tab has two panels. You can add and remove selected users and Groups As
Teams using the center buttons.
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Item Description

1 Groups panel Shows groups and their users.

2 Projects panel Shows projects and the users and groups assigned to each
project. You can manage user and group access to a project

3 Add, Remove, and
Add Groups As
Team

You can use the buttons in the center of the page to add and
remove selected users and Groups As Teams to and from
projects.

Every user must be on a team but can only belong to a single team per project. Failure to
assign a user to a team for a given project will result in a misconfiguration error.

Best practice is to add Groups As Teams to projects instead of adding individual users.

Users and Groups As Teams have the following access types:

l Read Only – Unable to make changes to a project even if they have roles that would otherwise
allow it.

l Write - The default access given to a user or group.

If you used the Add button, you can then simply click the checkbox in the Team column.
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15 .6 .3 EXPORT

You can export a Microsoft Excel file with user information and to which projects users are assigned to.
Export files are useful for audits.

To export, click Export in the top right of the page to download the file.
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CHAPTER 16 — MODEL MOB ILE

16 . 1 INTRODUCT ION

You can support the entire project lifecycle at the office or the worksite with the InEight Model mobile
application. In Model mobile, you have access to your model and model data to view and interact using
an iOS mobile device. The Model mobile application is available to download from the Apple App
Store.

16 . 2 OVERV IEW

When you open the application, a log in window shows:



After you log in, a list of the projects you have permissions to is shown:
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From the list of projects, tap a project to open it. The project opens to the Model viewer module,
which is the default landing module. You can switch modules by selecting theMainmenu, and then
selecting from the list of available project modules such as Model, Elements, Issues, and Archive
Library.

Model geometry will begin to load when an internet connection is active.

Some features are not fully functional until the entire tag library is downloaded to your device. A
warning banner shows at the top of the screen to communicate this state.
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Features of Model mobile include the following:

l Navigation - Typical iOS gestures. Read more

You can navigate in Model mobile using typical iOS one and two finger gestures such as tap,
scroll, select, orbit, pan, pinch open and pinch closed objects or models.

l Offline Data - You can download model data to your local device and use Model offline where
internet access is not available. Read more

Select the main menu > Offline Data >Master Presets to specify which data is downloaded for
offline mode.
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After you select Offline Data, you can choose which data to download in using the Master
Presets. You can choose individual master presets or collections of presets for offline mode.
Download status is shown next to the master preset.
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l Left ribbon menu - Standard Model functions. Read more
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1. Home – Applies the default project master preset.

2. Zoom Selected – Zooms the camera to frame the selection.

3. Isolate – Toggles between the entire model and an isolated view of the selected objects.

4. First-Person Navigation – Toggles first-person navigation.

5. Ortho/Perspective - Toggles between orthographical and perspective camera.

6. Grids – Toggles grid visibility on/off.

7. Selection Mode – Provides the ability to select objects related to the active mode.

InEight Inc.  |  Release 24.9 Page 527 of 558

Model User Guide 16.2 Overview



o Elements - Select objects that belong to the Element associated with the object
being selected.

o Tags - Select objects that belong to the tag associated with the object being
selected.

o Parent - Selects all objects belonging to the highest level.
o Object - Select the lowest level of an object.

l Right navigation menu - Find familiar model panels in the right vertical menu. Read more

Page 528 of 558 InEight Inc.  |  Release 24.9

16.2 Overview Model User Guide



InEight Inc.  |  Release 24.9 Page 529 of 558

Model User Guide 16.2 Overview



1. Master Presets – Navigate between master presets defined in Model desktop.

2. Model Streams – Turn visibility on or off for model streams and groups.
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3. Tags - You can navigate tag names and values and select associated model objects.
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4. Elements - Navigate elements and select associated model objects.

5. Style sets - Switch style sets to change how they visualize the model.
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6. Selection Info - Show attribute data of actively selected model objects in the Properties,
Tags, and Related tabs.
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l Object Properties – Show the model object properties such as Constraints,
Construction, and Dimensions.
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l Tags – Show any tags associated with the model object.
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l Related – Show any related information associated with the model object such as
associated elements, issues, checklists, and documents.
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16 .2 .1 CONSIDERATIONS

You only see projects that you have permission to access.

CHAPTER 16 — TAGS AND
OBJECTS

16 . 1 TAGS AND OBJECTS OVERV IEW

Tags are the organizational structure of model objects and define a set of identifiers (category and
value). You can interact with tags to manipulate your model in a variety of ways. For more information
about tags, see Tags and Objects Overview in Model desktop.

16 . 2 MANAGE TAGS

You can add new tag names, add tag values, update, and remove tag value associations.

16 .2 .1 STEPS

ADD NEW TAGS

1. In the ribbon menu on the right, tap the Tags icon to open the Tags list, and then tap the Add
icon.
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2. Enter the new tag information, and then tap Ok.

ADD AND UPDATE TAG VALUES

1. In the Tags list, swipe right on a tag, and then tap Select.

a. To update a tag, choose a tag value from the list, and then update the value.
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b. To add a tag value, tap the Add tag value icon, and then enter a new tag value.

REMOVE TAG VALUES

In the Tags list, swipe left on a tag, and then tap Remove.

16 . 3 STYLES

16 . 4 STYLE SETS

There are predefined style sets in Element Progress and Work Package Progress (AWP) when a project
is created, and the AWP is enabled. The default style sets are enabled in the Styling panel for Element
Progress and Work Package Progress Style Sets.
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Style sets created in Model desktop sync to Model mobile and can represent real-world material
characters such as glass and steel, or simple colors, to represent different disciplines or systems.

You can access Style sets by tapping the Style sets icon in the right navigation menu.

InEight Inc.  |  Release 24.9 Page 545 of 558

Model User Guide 16.4 Style Sets



The following image shows the Element Progress style set:
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The following image shows the Work Package Progress style set:
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The default styles are read-only and have predefined progress indicators that cannot be edited.

16 . 5 ELEMENTS

16 . 6 QUANT ITY CLA IM ING

You can perform claiming in the Elements panel’s Claiming tab and sync with InEight Plan. You can
mark the completion of claiming schemes in full or enter a partial install quantity.

The following image shows claiming in the Elements panel:
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16 .6 .1 STEPS

l Complete quantity claiming – Select a component in the Elements panel, click the Components
claiming icon, and then select the Edit component icon. Mark the claiming item’s checkbox to do
complete claiming.
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l Partial and complete quantity claiming – To do partial claiming, select a component in the
Elements panel, click the Components claiming icon, and then select the Edit component icon.
Tap on an item, tap Install Quantity, enter a quantity, and then click Ok.

You can also do full claiming, by select Yes in the Is Complete field.

When you do claim updates, the updates save to your Project Updates queue. When you sync, updates
for claiming sync with Plan. You must perform a sync operation to sync your updates to Plan.

16 .6 .2 CONSIDERATIONS

Reverse claiming must be done in the Plan application. After you reverse claiming quantities in Plan,
changes will sync in Model.
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16 . 7 ADVANCED WORK PACKAG ING &
WORKFACE PLANN ING

16 . 8 QUANT ITY CLA IM ING

You can perform claiming in the AWP panel’s Claiming tab, and then sync with InEight Plan. You can
mark the completion of claiming schemes in full or enter a partial install quantity.
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You can perform bulk and individual claiming at the CWP and IWP level by tapping the Claim icon.
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You can also perform partial and full claiming by tapping individual steps and entering the install
quantity or select Yes in the Is Complete field.
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When you perform claim updates, the updates are saved to your Project Updates queue, and then
when you perform a sync operation, the updates for claiming sync with Plan. You must perform a sync
operation to sync your updates to Plan.

16 .8 .1 CONSIDERATIONS

Reverse claiming must be done in the Plan application. After you reverse claiming quantities in Plan,
changes will sync in Model.
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